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Introduction to Value Line

Introduction

This module will cover the introduction to the MSP430 Value Line series of microcontrollers. In

the exercise we will download and install the required software for this workshop and set up the
hardware development tool — MSP430 LaunchPad.

Intr tion ine
Cod mposer Studio
Initialization and GPIO

Analog-to-Digital Converter
Interrupts and the Timer
Low-Power Optimization

Serial Communications

Portfolio ...

For future reference, the main Wiki for this workshop is located at:

http://processors.wiki.ti.com/index.php/Getting Started with the MSP430 LaunchPad Workshop
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Introduction to Value Line

Tl Processor Portfolio
TI Embedded Processing Portfolio

|| ARMP-Based Processors ” Digital Signal Processors (DSPs)

| Microcontroll ers (MCUs)
Cc2000™ B ™ ™ / \
A is® Sitara C6000 . -
MSP430™ Delfino ARS’\}E%!:’?;E_W ARMG®Cortex™-A8 DaVinci™ C6000 C5000
Piccolo™ & ARM9 video processors
OMAP 24.000
Upto 40MHz to Upto 300MHz to  |300MHz to >1Ghz| MMACS Up to 300 MHz
25 MHz 300 MHz 80 MHz >1GHz +Accelerator +Accelerator
Flash Flash, RAM Fash Cache, Cache Cache Up to 320KB RAM
1KBt0256 KB || 16KBto512KB || 8KB to256 KB RAM, ROM RAM, ROM RAM, ROM Up to 128KB ROM
Analog 1/0, ADC PWM, ADC, USB, ENET USB, CAN, USB, ENET, SRIO, EMAC USB, ADC
LCD, USB, RF CAN, PI,12C || MACHPHY CANi PCle, EMAC PCle, SATA, SPI DMA, PCle McBSP, SPI, 12C
Measurement, Motor Control, Connea'iv'ny, Security, || Industrial computing || FloatingFixed Point || Telecomtest & meas, Audio,Vdce
Sensing, General - Digital Power, Motion Control, HV [} POS& portable Video, Audio, Voice, media gateways, . . 5
Purpose Lighting,Ren. ENrgy || |nqustrial Automation data temind's Seaurity, Conferencing base stations Medicd,Biometrics
$0.25 to $9.00 $150 t0 $20.00 $1.00 to $8.00 $5.00to $20.00 $5.00 to $200.00 $40 t0 $200.00 $3.00 to $10.00
9 HE 2 HEie=U% % s
) = s
U 2 ) N

Bl = . Soitwae&Dev.Tools _ i TN |

Roadmap ...
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MSP430 Roadmap

| Device
() Production
() Development
100+ devices
2xx-Catalog
+ 16 MIPS
+ 120 kB Flash i
. & kpRAM The New Generation
+ 500 0A Standby EXX-BXX
v 18- 38V + 25MIPS
+ 256 kB Flash
G = Value Line i
F =Flash + FRAM, USB, RF
= G LCD Confroller
160 LAMIPS
100+ devices
4xx: LCD
+ 16 MIPS
120 kB Flash
& kB RAM
+ LCD Controller, 160
segments
+18-3.8V
Value Line Parts ...
Part# Program | SRAM | I/O 16-bit | Watchdog | BOR usl Comp Temp ADC 1kU
MSP430G (kB) (B) Timer (RC/SPI) _A+ Sensor | Ch/Res | Price
2001 0.5 128 10 1 Y Y - - $0.34
2101 1 128 10 1 Y Y - $0.44
2121 1 128 10 1 Y Y Y - - - $0.46
2201 2 128 10 1 Y Y $0.47
2221 2 128 10 1 Y Y Y $0.48
2111 1 128 10 1 Y Y Y - - $0.46
2211 2 128 10 1 Y Y Y - - $0.48
2131 1 128 10 1 Y Y Y N Y 8/10 $0.49
2231 2 128 10 1 Y Y Y - Y 8/10 $0.52

Power consumption @ 2.2V:
¢ 0.1 pA RAM retention
¢ 0.4 pA Standby mode (VLO)
« 0.7 pA real-time clock mode
e 220 pA/ MIPS active
Ultra-Fast Wake-Up From Standby Mode in<1 ps

CPU ...
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MSP430 CPU
AN\
‘ RO/ PC (Program Counter) ‘
¢ 100% code compatible with | TEE }
earlier versions } - — |
¢ 1MB unified memory map R4 | Re |
+ No paging ., ’% :Z }
¢ Extended addressing modes | |§| [r7 | R7 &
< F b=
+ Page-free 20-bit reach g| LR8I R8 } &
o R9
+ Improved code density ° ’% — |
+ Faster execution RIL | R11 |
¢ Full tools support through R 22 ‘
IAR and CCS G T
R14 R14 \
[R15 R15 |
N N
Memory Map ...
Memory Map
Memory Map
x2231 shown
¢ Flash programmable via JTAG or OFFFFh | Interupt Vector Table
In-System (ISP) OEFEGh
¢ ISP down to 2.2V. Single-byte or FFDFh Flash/ROM
Word OF800h
¢ Interruptible ISP/Erase ﬁ
¢ Main memory: 512 byte segments Informati
(O-n). Erasable indiv?tltitually orall %ﬁ%%gﬂ ”w?é%#?"
¢ Information memory: 64 byte
segments (A-D) II
+ Section A contains device-specific 027Fh RAM
calibration data and is lockable 0200h
¢ Programmable Flash Memory 01FFh 16-bit
Timing Generator 0100h ez
8-bit
%T;n Peripherals
OFh 8-bit Special
Function
oh Registers
Peripherals ...
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Value Line Peripherals

Value Line Peripherals

¢ 10-bits of General Purpose I/0O
» 8-bits on port P1 and 2-hits on port P2
+ Independently programmable

« Any combination of input, output, and interrupt (edge
selectable) is possible

+ Read/write access to port-control registers is supported by
all instructions

+ Each I/O has an individually programmable pull-up/pull-
down resistor yprog P PP

¢ 16-bit Timer_A2
» 2 capture/compare registers
+ Extensive interrupt capabilities
¢ WDT+ Watchdog Timer
+ Also available as an interval timer
¢ Brownout Reset
« Provides correct reset signal during power up and down
+ Power consumptionincluded in baseline current draw

Peripherals ...

Value Line Peripherals

¢ Universal Serial Interface (USI)
« Basic hardware for SPI and 12C
+ Master or Slave modes
+ Programmable clock

¢ Comparator_A+
« Inverting and non-inverting inputs
+ Selectable RC output filter
+ Output to Timer_A2 capture input
+ Interrupt capability
¢ 8 Channel/10-bit 200 ksps SAR ADC
« 8 external channels (device dependent)
« Voltage and Internal temperature sensors
+ Programmable reference

+ Direct transfer controller send results to conversion
memory with CPU intervention

« Interrupt capable Board ...
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LaunchPad Development Board

USB Emulator
Connection Iﬂ

Chip Pinouts

P1.3 Button =)

P1.0& P1.6

LaunchPad Development Board

Embedded Emulation
{1 6-pin eZ430 Connector

: _ Crystal Pads
B e Pt and Socket

___} " —1Power Connector

LEDs and Jumpers Iﬁ E Reset Button

Lab...
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Lab 1: Download Software and Setup Hardware

Lab 1: Download Software and Setup Hardware

Objective

The objective of this lab exercise is to download and install Code Composer Studio, as well as
download the various other support documents and software to be used with the MSP430
LaunchPad. Then we will review the contents of the MSP430 LaunchPad kit and verify its
operation with the pre-loaded demo program. Basic features of the MSP430 LaunchPad running
the MSP430G2231 will be explored. Specific details of Code Composer Studio will be covered
in the next lab exercise. These development tools will be used throughout the remaining lab
exercises in this workshop.

Labl: Hardware Setup

* Download and install tools
and documentation

» Review kit contents
e Connect hardware
 Test preloaded software
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Procedure

Note:

If you have already installed CCSv4.1, please skip this installation procedure.

Download and Install Code Composer Studio 4.1

1.

Click the following link to be directed to the CCS download Wiki:

http://processors.wiki.ti.com/index.php/Download CCS

Then select the second download button, “Download latest production MSP430/C28x
code limited image”, as shown below:

Download latest production MSP430/C28x code size limited image

% DOWNLOAD.

This will direct you to the “my.TI Account” where you will need to log in (note you must
have a Tl log in account to proceed). Once you agree to the export conditions you will
then be e-mailed a link to the installation zip file. Click on the link and save the zip file
to your desktop. Unzip the file into a folder on your desktop named Setup CCS. You can
delete the zip file and the Setup CCS folder when the installation has completed.

Be sure to disconnect any evaluation board that you have connected to your PCs USB
port(s).

Open the Setup CCS folder on your desktop and double-click on the file named
setup_CCS_MC_Core_n.n.n.n.exe.

Getting Started with the MSP430 LaunchPad - Introduction to Value Line


http://processors.wiki.ti.com/index.php/Download_CCS

Lab 1: Download Software and Setup Hardware

6. Follow the instructions in the Code Composer Studio installation program. Select the
MSP430-only Core Tools for installation when the Product Configuration dialog win-

dow appears. Click Next.

Code Composer Studio v4 Setup

Product Configuration

Select the Product Configuration that best suits your needs,

L

r

it

X]

¢ e'.‘

Nig 9
Boe

presented on the next screen,

Descripkion

Microcontroller Core Edition

M3P430-only Core Tools
C2000-only Core Tools

is in place,

Select the Product Configuration that you wish tainstall. More detailed installation options will be

Subset of the Microconkroller
Edition supporting MSP430.

A 16KE object code size limit

[ < Back, l ’ Mexk =

J |

Cancel

|

7. Use the default settings in the Select Components dialog and click Next. Then click Next
in the Start Copying Files dialog. The installation should take less than 10 minutes to

complete.

Code Composer Studio v4 Setup

Select Components

Select the components you want bo install and deselect the components
vou do not wank ta install,

8] ik
= (Code Composer Studio vd SR

Inteqgrated Development Enviranment
Code Generation Tools
= Ernulators
MSP430 LISE FET
O msp4zn Parallel Part FET
Documentation

357.63 MB of space required to inskall selected configuration,
14,17 &B is available on the current drive,

[ < Back. ]| Mext =

|

Cancel

)

At this point CCSv4.1 has been installed. In the next module we will start, configure and

learn more about the basic operations of CCS.
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Download and Install Workshop Lab and Solution Files

8. Click the following link to be directed to the MSP430 LaunchPad Workshop download
Wiki and save the MSP430_LaunchPad_Workshop.exe file to your desktop:

http://software-dl.ti.com/trainingTTO/trainingTTO public sw/MSP430 LaunchPad Wo
rkshop/MSP430 LaunchPad Workshop.exe

9. Double-click the MSP430_LaunchPad_Workshop.exe file to install the labs and solutions
for this workshop. Once installed, you can delete the installation file from the desktop.
The workshop files will be installed in C:\MSP430_LaunchPad and the directory
structure is as follows:

=) MaP430_LaunchPad

=I-{_) Labs
41+ ) Labz
+1- ) Lab3
+ ) Lab4
+) Lab&
41/} Labs
++ ) Lab?

=112 Solutions
+ ) Lab2
+1- ) Lab3
+) Lab4
+1 ) Labs
41+ Lab&

++ ) Lab?
{2 Workspace

Download Supporting Documents and Software
10. Next, download and save the following documents and software to your computer:

e LaunchPad User’s Guide: http://focus.ti.com/lit/ug/slau318/slau318.pdf

e MSP430x2xx User’s Guide: http://focus.ti.com/lit/ug/slaul44f/slaul44f.pdf

e C Compiler User’s Guide http://www.ti.com/litv/pdf/slaul32e

o MSP430G2xx code examples: http://www.ti.com/lit/zip/slac463a

e Temperature demo source: http://www.ti.com/litv/zip/slac435

e Temperature demo GUI source files:

http://dl.dropbox.com/u/9458154/LaunchPad Temp GUI.zip

Additional information is available on the MSP430 LaunchPad Wiki at
www.ti.com/launchpadwiki
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MSP-EXP430G2 LaunchPad Experimenter Board

The MSP-EXP430G2 is a low-cost experimenter board, also know as LaunchPad. It provides
a complete development environment that features integrated USB-based emulation and all of
the hardware and software necessary to develop applications for the MSP430G2xx Value
Line series devices.

11. Open the MSP430 LaunchPad kit box and inspect the contents. The kit includes:

e LaunchPad emulator socket board (MSO-EXP430G2)
¢ Mini USB-B cable

e A MSP430G2231 (pre-installed and pre-loaded with demo program) and
a MSP430G2211

e 10-pin PCB connectors (two male and two female)
e 32.768 kHz clock crystal
e Quick start guide and two LaunchPad stickers

Hardware Setup

The LaunchPad experimenter board includes a pre-programmed MSP430G2231 device which
is already located in the target socket. When the LaunchPad is connected to your PC via
USB, the demo starts with an LED toggle sequence. The on-board emulator generates the
supply voltage and all of the signals necessary to start the demo.

12. Connect the MSP430 LaunchPad to your PC using the included USB cable. The driver
installation starts automatically. 1f prompted for software, allow Windows to install the
software automatically.

13. At this point, the on-board red and green LEDs should be in a toggle sequence. This lets
us know that the hardware is working and has been setup correctly.
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Running the Application Demo Program

The pre-programmed application demo takes temperature measurements using the internal
temperature sensor. This demo exercises the various on-chip peripherals of the
MSP430G2231. These peripherals include the 10-bit ADC, which samples the internal
temperature sensor, and the 16-bit timers, which drive the PWM to vary brightness of the
LEDs. Additionally, the 16-bit timers enable a software UART for communication with the
PC. This is used with the downloadable GUI to display data that is being communicated back
to the PC from the LaunchPad.

14. Press button P1.3 (lower-left) to switch the application to the temperature measurement
mode. A temperature reference is taken at the beginning of this mode and the LEDs on
the LaunchPad signal a rise or fall in temperature by varying the brightness of the on-
board red or green LED, respectively.

You can re-calibrate the temperature reference with another press on button P1.3. Try
increasing and decreasing the temperature on the device (rub your fingertip on your pants
to warm it up or place your fingertip on a cold drink then place on the top of the device).
Notice the change in the LED brightness.

15. Next we will be using the GUI to display the temperature readings on the PC. Be sure
that you have installed the downloaded GUI source files (LaunchPad_Temp_GUI.zip).

16. Determine the COM port used for the board by clicking (in Windows) Start 2 Run then
type devmgmt.msc in the box and select OK. (In Windows 7, just type into the Search
programs and files box)

In the Device Manager window that opens, left-click the symbol left of
Ports (COM & LPT) and record the COM port number for
MSP430 Applications UART (COMXxXx): . Close the Device Manager.

17. Start the GUI by clicking on LaunchPad_Temp_GUl.exe. This file is found under
<Install Directory>\LaunchPad_Temp_GUNapplication.window. You may have to select
Run in the “Open File — Security Warning” window.

18. It will take a few seconds for the GUI to start. Be sure that the application is running (i.e.
button P1.3 has been pressed). In the GUI, select the COM port found in step 16 and
press Enter. The current temperate should be displayed. Try increasing and decreasing
the temperature on the device and notice the display reading changes. Note that the
internal temperature sensor is not calibrated. Therefore, the reading displayed will not be
accurate. We are just looking for the temperature values to change.

ST

You’re done.
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Code Composer Studio

Introduction

This module will cover a basic introduction to Code Composer Studio. In the lab exercise we
show how a project is created and loaded into the flash memory on the MSP430 device.
Additionally, as an optional exercise we will provide details for soldering the crystal on the

LaunchPad.

Intr tion ine

Cod mposer Studio

Initialization and GPIO
Analog-to-Digital Converter
Interrupts and the Timer
Low-Power Optimization
Serial Communications
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Code Composer Studio

Integrated Development Environments — CCS and IAR

Code Composer Studio 4.1

¢ Code Composer Studio v4.1: _
A single development g
platform for all Tl processors =

¢ Enhancements:
+Speed
+Code sizeimprovements i — i
-Auto-updating -

+License manager

+Support for all TI MCUs
¢ Only $495 for MCU license
¢ FREE 16KB-limited edition

IAR ...

IAR Kickstart

CFdd & [ z wEZEE b 3t o]

+ 4kB Compiler

+ Supports all MSP430
variants

+ Assembler/Linker

+ Editor

+ Debugger

CCS Detalils ...
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Code Composer Studio: IDE
Code Composer Studio: IDE

+= - Code Composer Studio (License
BB C/Ce = . Code Composer Studio (L )

1 B Doty | G CiCes

“.
bR ¢ Integrates: edit, code generation,

) MSP4I0G2ZY el [Aectivn]
1] I mopa 302231 omd

and debug

¢ Single-click access using buttons

¢ Powerful graphing/profiling tools

Automated tasks using Scripts

Based on the Eclipse open
source software framework

=

[Tonirgore sim_Socn oty

C/C++ and Debug Perspective (CCSv4)

¢ Each Perspective provides a set of functionality
aimed at accomplishing a specific task

¢ C/C++ Perspective ¢ Debug Perspective

+ Displays views used
during code development

« CJ/C++ project, editor, etc.

+ Displays views used for
debugging
+ Menus and toolbars
associated with debugging,

watch and memory
windows, graphs, etc.
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CCSv4 Project

B CiC++ - Code Composer, Studio (Licens

File Edit Wiew Mavigate Project Target Too

RE® %%

CCSv4 Project

Project files contain:

= ml

=R
= 'bc Temperature_Sense_Demo [Active
< Einaries
E Includes
(= Debug
(€] main.c
(% MSP430G2231. coxml [Active]
@ Ink_msp430g2231 .cmd

¢ Listof files:

+ Source (C, assembly)

+ Libraries

+ Linker command files

¢ Project settings:

+ Build options (compiler,
Linker, assembler, etc)

+ Build configurations

3 Ardditional Project Settings

¢ File 2 New - CCS Project

Doefiree the inber-progect dependences, Fany.

l CES Project e
Craste & revr O3 Progact, r
[
Brojedt name: | Tampérsture_Sensa_Demo
[ e defon kocstion,
Loseation: | C:MEPAR0_Lamsx el L ab [Labi3 Prject TS Eromess....
z cancel_]

5 Hew CCS Project

2 Select a type of project

L

Project Type: | M4 v
Configrations:
[#] B0ty r
B B

Dimbect 2 |
] aowe A Prajenct Types
[l stvowe Al Corium sticrs.
i [ clos || gt | cww |

\=F Projets | €IS+ Indecer
Babermemd Prosmcts.

Creating a New CCSv4 Project

4 9 New CCS Project

CCS Project Settings
Salact the CCS propact settngs,

| Otz type: | Exmcutable

[ -

Davice Variant: caslect Fbees | MEPAINGEEIL
Duvice Endarress:

Code Gener stion took: | 11¥2,3,0

Subgrd Formab:

Winker Comemand Fia: I g gD e

Rurkime Support Lbrary; | coutomatics

[ Treak & an Assembiy-ondy protect

Tkt

{%iNore

() Eruaties RTSE spport (roxuarnd For BOS w6, xx, Codee Engne v.xx, ohe.)

2 [ <eo ] [omh J[ coel ]
Lab ...
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Lab 2: Code Composer Studio

Objective

The objective of this lab is to learn the basic features of Code Composer Studio. In this exercise
you will create a new project, build the code, and program the on-chip flash on the MSP430
device. An optional exercise will provide details for soldering the crystal on the LaunchPad.

Lab2: Code Composer Studio

eLab
*Re-create temperature sense demo
*Program part and test
*Optional
e Add microcrystal to board
» Program part to test crystal

. LaunchPad

Getting Started with the MSP430 LaunchPad - Code Composer Studio



Lab 2: Code Composer Studio

Procedure

CCSv4.1 should have already been installed during the Labl exercise.

Start Code Composer Studio and Open a Workspace
1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or

selecting it from the Windows Start menu. When CCS loads, a dialog box will prompt
you for the location of a workspace folder. Browse to:
C:\MSP430_LaunchPad\WorkSpace and do not check the “Use this as the default ...”
checkbox. Click OK.

This folder contains all CCS custom settings, which includes project settings and views
when CCS is closed, so that the same projects and settings will be available when CCS is
opened again. The workspace is saved automatically when CCS is closed.

The first time CCS opens, a “Welcome to Code Composer Studio v4” page appears.
Close the page by clicking on the CCS icon in the upper right or by clicking the X on the
“Welcome” tab. You should now see an empty CCS workbench. The term workbench
refers to the desktop development environment. Maximize CCS to fill your screen.

The workbench will open in the “C/C++ Perspective” view. Notice the C/C++ icon in
the upper right-hand corner. A perspective defines the initial layout views of the
workbench windows, toolbars, and menus which are appropriate for a specific type of
task (i.e. code development or debugging). This minimizes clutter to the user interface.
The “C/C++ Perspective” is used to create or build C/C++ projects. A “Debug
Perspective” view will automatically be enabled when the debug session is started. This
perspective is used for debugging C/C++ projects. You can customize the perspectives
and save as many as you like.
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Create a New Project

3. A project contains all the files you will need to develop an executable output file (.out)
which can be run on the MSP430 hardware. To create a new project click:

File > New - CCS Project

In the Project name field type Temperature_Sense_Demo. Uncheck the “use default
location” box. Click the Browse... button and navigate to:

C:\MSP430_LaunchPad\Labs\Lab2\Project-TS
Click OK and then click Next.

4. The next window that appears selects the platform and configurations. The “Project
Type” should be set to “MSP430”. In the “Configurations” box below, leave the
“Debug” and “Release” boxes checked. This will create folders that will hold the output
files. Click Next.

5. In the next window, inter-project dependencies (if any) are defined (there are none now).
Select Next.

6. In the last window, the CCS project settings are selected. Select the “Device Variant”
using the pull-down list and choose “MSP430G2231”. This will select the appropriate
linker command file, runtime support library, set the basic build options for the linker and
compiler, and set up the target configuration. Click Finish.

7. A new project has now been created. Notice the C/C++ Projects window contains
Temperature_Sense_Demo. The project is set Active and the output files will be
located in the Debug folder. At this point, the project does not include any source files.
The next step is to add the source files to the project.
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Create a Source File

8. To add a source file to the project, right-click on Temperature_Sense_Demo in the

C/C++ Projects window and select:

New - Source File

orclick: File > New - Source File

Name the source file main.c and click Finish. An empty window will open for the
main.c code.

Next, we will add code to main.c. Rather than create a new program, we will use the
original source code that was preprogrammed into the MSP430G2231 device (i.e.
program used in Labl).

Click File > Open File..and navigate to
C:\MSP430_ LaunchPad\Labs\Lab2\Files.

Open the Temperature_Sense_Demo.txt file. Copy and paste its contents into main.c.
Then close the Temperature_Sense_Demo.txt file. This file is no longer needed. Be sure

to save main.c by click the Save button a=t in the upper left.
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Build and Load the Project

10. Three buttons on the horizontal toolbar control code generation. Hover your mouse over
each button as you read the following descriptions:

= e -l i
L= W~ ﬁ :
Button Name Description
1 Build Incremental build and link of only modified source files
2 Rebuild Full build and link of all source files
3 Debug Automatically build, link, load and launch debug-session

11. Click the “Build” button and watch the tools run in the Console window. Check for any
errors in the Problems window. If you get an error, you will see the error message (in
red) in the Problems window. By double-clicking the error message, the editor will
automatically open to the source file containing the error, and position the mouse cursor
at the correct code line. For future knowledge, realize that a single code error can
sometimes generate multiple error messages at build time.

12. CCS can automatically save modified source files, build the program, open the debug
perspective view, connect and download it to the target (flash device), and then run the
program to the beginning of the main function.

Click on the “Debug” button (green bug) or
Click Target > Debug Active Project.

Notice the Debug icon in the upper right-hand corner indicating that we are now in the
“Debug Perspective” view. The program ran through the C-environment initialization
routine in the runtime support library and stopped at main() function in main.c.
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Debug Environment

13. The basic buttons that control the debug environment are located in the top of CCS:

ol e 3 Q- B
O - - 3 3D @ I e o

1

The start debugging and program execution descriptions are shown below:

Start debugging

Image Name Description Availability

New Target Creates a new target configuration file. File New

Configuration Menu
Target
Menu

i

% Debug Active Starts a debug session based on the active project. Debug
Project Toolbar

Target

Menu

iﬁ Launch Tl De- | Starts the debugger with the default target configuration. Debug
bugger Toolbar

Target

Menu

ﬁ Debug Opens a dialog to modify existing debug configurations. Its drop Debug
down can be used to access other launching options. Toolbar

Target

Menu

Connect Tar- Connect to hardware targets. Tl Debug
get Toolbar
Target
Menu
Debug View
Context
Menu

$1

[ Terminate All Terminates all active debug sessions. Target
Menu
Debug View
Toolbar
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Program execution

Image Name Description Availability
oo Halt Halts the selected target. The rest of the debug views will update Target
automatically with most recent target data. Menu
Debug View
Toolbar
[ Run Resumes the execution of the currently loaded program from the Target
current PC location. Execution continues until a breakpoint is en- Menu
countered. Debug View
Toolbar
~='.;I Run to Line Resumes the execution of the currently loaded program from the Target Me-
current PC location. Execution continues until the specific nu
source/assembly line is reached. Disassembly
Context
Menu
Source Edi-
tor Context
Menu
11 Go to Main Runs the programs until the beginning of function main in Debug View
reached. Toolbar
i Step Into Steps into the highlighted statement. Target
Menu
Debug View
Toolbar
= Step Over Steps over the highlighted statement. Execution will continue at
; . - - Target
the next line either in the same method or (if you are at the end Menu
of a method) it will continue in the method from which the cur- -

. - Debug View
rent method was called. The cursor jumps to the declaration of Toolbar
the method and selects this line.

_IE Step Return Steps out of the current method. Target
Menu
Debug View
Toolbar
c& Reset Resets the selected target. The drop-down menu has various ad- Target
vanced reset options, depending on the selected device. Menu
Debug View
Toolbar
@h Restart Restores the PC to the entry point for the currently loaded pro- Target
gram. If the debugger option "Run to main on target load or re- Menu
start" is set the target will run to the specified symbol, otherwise Debug View
the execution state of the target is not changed. Toolbar
S Assembly The debugger executes the next assembly instruction, whether TI Explicit
Step Into source is available or not. Stepping
Toolbar
Target Ad-
vanced
Menu
L) Assembly The debugger steps over a single assembly instruction. If the TI Explicit
Step Over instruction is an assembly subroutine, the debugger executes the Stepping
assembly subroutine and then halts after the assembly function Toolbar
returns. Target Ad-
vanced
Menu
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14. At this point you should still be at the beginning of main(). Click the Run button to run
the code. Notice the red and green LEDs are toggling, as expected.

15. Click Halt. The code should stop in the PreApplicationMode() function.

16. Next single-step (Step Into) the code once and it will enter the timer ISR for toggling the
LEDs. Single-step a few more times and notice that the red and green LEDs alternate on
and off.

17. Click Reset CPU » and you should be back at the beginning of main().

Terminate Debug Session and Close Project

18. The Terminate Al button will terminate the active debug session, close the
debugger and return CCS to the “C/C++ Perspective” view.

Click: Target > Terminate Al oruse the Terminate Al button: & -
Close the Terminate Debug Session “Cheat Sheet” by clicking on the X on the tab.

19. Next, close the project by right-clicking on Temperature_Sense_Demo in the
C/C++ Projects window and select Close Project.
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Optional Lab Exercise — Crystal Oscillator

Objective

The MSP430 LaunchPad kit includes an optional 32.768 kHz clock crystal that can be soldered
on the board. The board as-is allows signal lines XIN and XOUT to be used as multipurpose
1/0s. Once the crystal is soldered in place, these lines will be a digital frequency input. Please
note that this is a delicate procedure since you will be soldering a very small surface mount
device with leads 0.5mm apart on to the LaunchPad.

The crystal was not pre-soldered on the board because these devices have a very low number of
general purpose I/O pins available. This gives the user more flexibility when it comes to the
functionality of the board directly out of the box. It should be noted that there are two 0 ohms
resistors (R28 and R29) that extend the crystal pin leads to the single-in-line break out connector
(J2). In case of oscillator signal distortion which leads to a fault indication at the basic clock
module, these resistors can be used to disconnect connector J2 from the oscillating lines.

Procedure

Solder Crystal Oscillator to LaunchPad

1. Very carefully solder the included clock crystal to the LaunchPad board. The crystal
leads provides the orientation. They are bent in such a way that only one position will
have the leads on the pads for soldering. Be careful not to bridge the pads. The small size
makes it extremely difficult to manage and move the crystal around efficiently so you
may want to use tweezers and tape to arranging it on the board. Be sure the leads make
contact with the pads. You might need a magnifying device to insure that it is lined up
correctly. You will need to solder the leads to the two small pads, and the end opposite
of the leads to the larger pad.

Click this link to see how one user soldered his crystal to the board:

http://justinstech.org/2010/07/msp430-launchpad-dev-kit-how-too/

Verify Crystal is Operational

2. Create a new project (File > New > CCS Project) and name it
Verify_ Crystal. Uncheck the “use default location” box. Using the Browse...
button navigate to: C:\MSP430_LaunchPad\Labs\Lab2\Project-VC. Click
OK and then click Next. The next three windows should default to the options
previously selected (project type MSP430, no inter-project dependencies selected, and
device variant set to MSP430G2231). Use the defaults and at the last window click
Finish.
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Add the source file to the project by right-clicking on Verify_Crystal in the C/C++
Projects window and select:

New - Source File

or click: File > New - Source File
Name the source file main.c and click Finish.

An empty window will open for the main.c code. Next, we will copy the source file for
the demo and paste it into main.c.

In the empty window add the code for main.c. by:

Click File > Open File..and navigate to
C:\MSP430_ LaunchPad\Labs\Lab2\Files.

Open the Verify_Crystal.txt file. Copy and paste its contents into main.c. Then close
the Verify_Crystal.txt file — it is no longer needed. Be sure to save main.c.

Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Problems window.

Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of Main().

Run the code. If the crystal is installed correctly the red LED will blink slowly. (It
should not blink quickly). If the red LED blinks quickly, you’ve probably either failed to
get a good connection between the crystal lead and the pad, or you’ve created a solder
bridge and shorted the leads. A good magnifying glass will help you find the problem.

Terminate Debug Session and Close Project

8.

Terminate the active debug session using the Terminate AlI button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

Next, close the project by right-clicking on Verify_Crystal in the C/C++
Projects window and select Close Project.

ST

You’re done.
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Initialization and GPIO

Introduction

This module will cover the steps required for initialization and working with the GP10. Topics
will include describing the reset process, examining the various clock options, and handling the
watchdog timer. In the lab exercise you will write initialization code and experiment with the
clock system.

Intr tion ine

Code Composer Studio

[ Initialization and GPIO |

Analog-to-Digital Converter
Interrupts and the Timer
Low-Power Optimization

Serial Communications

Reset State ...

Getting Started with the MSP430 LaunchPad - Initialization and GP1O 3-1



Module Topics

Module Topics
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Reset and Software Initialization

System State at Reset

¢ At power-up (PUC), the brownout circuitry holds device in reset until
Vcc is above hysteresis point

¢ RST/NMI pin is configured as reset

¢ 1/Opins are configured as inputs

¢ Clocks are configured

¢ Peripheral modules and registers are initialized (see user guide for
specifics)

¢ Status register (SR) is reset

¢ Watchdog timer powers up active in watchdog mode

¢ Program counter (PC) is loaded with address contained at reset
vector location (OFFFEh). If the reset vector content is OFFFFh, the
device will be disabled for minimum power consumption

SWinit ...

Software Initialization

After a system reset the software must:

¢ Initialize the stack pointer (SP), usually to the top of
RAM

¢ Reconfigure clocks (if desired)

¢ Initialize the Watchdo? timer to the requirements of
the application, usually OFF for debugging

¢ Configure peripheral modules

Clock System ...
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Clock System

Clock System

¢ Very Low Power/Low Frequency VLO
Oscillator (VLO)*
« 4 - 20kHz (typical 12kHz) Min. Puls ' ACLK
Filter Peripherals

+ 500nA standby

+ 0.5%/°C and 4%/Volt drift

+ Notin'21x1 devices OsC_Faut :DA VLK
¢ Crystal oscillator (LFXT1)

+ Programmable capacitors

. Failsafe OSC_FaUlt 16MHz SMCLK
DCO d Peripherals

+ Minimum pulse filter

¢ Digitally Controlled Oscillator
(DCO) On PUC, MCLK and SMCLK are

sourced from DCOCLK at ~1.1 MHz.

+ <lps 0-to-16MHz ACLK is sourced from LFXT1CLK in
n LF mode with an intemal load
+ +3%tolerance capacitance of 6pF. If LFXT1 fails,
« Factory calibration in Flash ACLK defaults to VLO.
*Not on all devices. Check the datasheet DCO ...

F2xx - No Crystal Required - DCO
F2xx - No Crystal Required - DCO

DCO Calibration Data (provided from factory in flash info memory segment A)
DCO Frequency Calibration Register Size Address
1MHz CALBC1_1MHz byte 010FFh
CALDCO_1MHz byte 010FEh
8 MHz CALBC1_8MHz byte 010FDh
CALDCO_8MHz byte 010FCh
12 MHz CALBC1_12MHz byte 010FBh
CALDCO_12MHz byte 010FAh
16 MHz CALBC1_16MHz byte 010F9h
CALDCO_16MHz byte 010F8h

// Setting the DCO to 1MHz
if (CALBC1_1MHZ ==0xFF ]] CALDCO_1MHZ == OxFF)

while(1); // Erased cal data? Trap!
BCSCTL1 = CALBC1_1MHZ; // Set range
DCOCTL CALDCO_1MHZ; // Set DCO step + modulation

VLO CAL ...
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Optional: “Calibrating” the VLO
Optional: “Calibrating” the VLO

Calibrated 1 MHz DCO

T TAR

f\/Lo =8MHz/Counts ;
4 I —» CORx

ACLK/8 from VLO

Calibrate the VLO during runtime

Clock Timer_A runs on calibrated IMHz DCO
Capture with rising edge of ACLK/8 from VLO
fyLo = 8MHz/Counts

Code library on the web (SLAA340)

L K IR JER 2B 4

MCLK & Ve ...

System MCLK & Vcc
System MCLK & Vcc

A
Legend:
16 MHz
Supply voltage range
N during flash memory
S programming
1 12 MHz
&
c
g Supply voltage range
g during program execution
'S
5 6 MHz
©
2
w
>

18V 22V 27V 33V 36V
Supply Voltage -V
@ Match needed clock speed with required Vcc to achieve the lowest possible

power consumption. Unreliable execution will result if \Vcc drops below the
minimum required for the selected frequency.

¢ All G2 device operate up to 16MHz. 1st phase devices only provide 1IMHz DCO
constant. Higher frequencies must be manually calibrated. 2nd phase will have
all constants. Always check the datasheet.

WOT faiksafe ...
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Watchdog Timer

Watchdog Timer Failsafe Operation

¢ If ACLK / SMCLK fail,
clock source = MCLK _
(WDT+ fail safe feature) ooblt
¢ If MCLK is sourced from cLK
a crystal, and the crystal fovrrr wvvert
fails, MCLK = DCO MCLK—y Fail-Safe
(XTAL fail safe feature) i Logic
e
SMCLK—»{ T
ACLK—r| 1
WDTSSEL A EN DTHOLD

WOT clock source ...

Watchdog Timer Clock Source

WDTCTL (16-Bit)

WDTHOLD
WDTNMIES
— MCLK Active

WDTNMI Clock
WDTTMSEL » Request —> SMCLK Active
WDTCNTCL — Logic L, acikacive
WDTSSEL
WDTIS1
WDTISO

¢ Active clock source cannot be disabled (WDT mode)
¢ May affect LPMx behavior & current consumption
¢ WDT(+) always powers up active
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Lab 3: Initialization and GPIO

Objective

The objective of this lab is to learn about steps used to perform the initialization process on the
MSP430 Value Line devices. In this exercise you will write initialization code and run the device
using various clock resources.

Lab3: Initialization

» Write initialization code

* Run CPU on MCLK sourced by:
*VLO
« 32768 crystal
* DCO

* Program part

* Observe LED flash speed
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Procedure

Create a New Project

1. Create a new project (File > New - CCS Project) and name it Lab3.
Uncheck the “use default location” box. Using the Browse... button navigate to:
C:\MSP430_LaunchPad\Labs\Lab3\Project. Click OK and then click Next.
The next three windows should default to the options previously selected (project type
MSP430, no inter-project dependencies selected, and device variant set to
MSP430G2231). Use the defaults and at the last window click Finish.

Create a Source File

2. Add asource file to the project (File > New -> Source File)and name it
Lab3.c and click Finish.

3. In the empty window type the following code into Lab3.c:

#include <msp430g2231.h>

void main(void)

{

//code goes here

b

Running the CPU on the VLO

We will initially start this lab exercise by running the CPU on the VLO. This is the slowest clock
which runs at about 12 kHz. So, we will visualize it by blinking the red LED slowly at a rate of
about once every 3 seconds. We could have let the clock system default to this state, but instead
we will set it specifically to operate on the VLO. This will allow us to change it later in the
exercise. We will not be using any ALCK clocked peripherals in this lab exercise, but you should
recognize that the ACLK is being sourced by the VLO.

4. In order to understand the following steps, you need to have the following two resources
at hand:
e MSP430G2231.h header file — search your drive for the msp430g2231._h
header file and open it. This file contains all the register and bit definitions for
the MSP430 device that we are using.

e MSP430G2xx User’s Guide — this document (slaul44e) was downloaded in
Labl. This is the User’s Guide for the MPS430 Value Line family. Open the
.pdf file for viewing.

3-8 Getting Started with the MSP430 LaunchPad - Initialization and GP1O



Lab 3: Initialization and GPIO

5. For debugging purposes, it would be handy to stop the watchdog timer. This way we
need not worry about it. In Lab3.c right at //code goes here type:

WDTCTL = WDTPW + WDTHOLD;
(Be sure not to forget the semicolon at the end).

The WDTCTL is the watchdog timer control register. This instruction sets the password
(WDTPW) and the bit to stop the timer (WDTHOLD). Look at the header file and User’s
Guide to understand how this works. (Please be sure to do this — this is why we asked
you to open the header file and document).

6. Next, we need to configure the LED that is connected to the GPIO line. The green LED
is located on Port 1 Bit 6 and we need to make this an output. The LED turns on when
the bit is setto a “1”. We will clear it to turn the LED off. Leave a line for spacing and
type the next two lines of code.

P1DIR = 0x40;
P10OUT = O;

(Again, check the header file and User’s Guide to make sure you understand the
concepts).

7. Now we will set up the clock system. Enter a new line, then type:

BCSCTL3 |= LFXT1S_2;

The BCSCTL3 is one of the Basic Clock System Control registers. In the User’s Guide,
section 5.3 tells us that the reset state of the register is 005h. Check the bit fields of this
register and notice that those settings are for a 32768 Hz crystal on LFXT1 with 6pF
capacitors and the oscillator fault condition set. This condition would be set anyway
since the crystal would not have time to start up before the clock system faulted it.
Crystal start-up times can be in the hundreds of milliseconds.

The operator in the statement logically OR’s LFXT1S_2 (which is 020h) into the
existing bits, resulting in 025h. This sets bits 4 & 5 to 10b, enabling the VLO clock.
Check this with the documents.

8. The clock system will force the MCLK to use the DCO as its source in the presence of a
clock fault (see the User’s Guide section 5.2.7). So we need to clear that fault flag. On
the next line type:

IFG1 &= ~OFIFG;

The IFG1 is Interrupt Flag register 1. One bit field in the register is the Oscillator Fault
Interrupt Flag - OF I FG (the first letter is an “O”, and not a zero). Logically ANDing

1 FG1 with the NOT of OFIFG (which is 2) will clear bit 1. Check this in section 5 of
the User’s Guide and in the header file.
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9.

10.

11.

12.

We need to wait about 50 ps for the clock fault system to react. Stopping the DCO will
buy us that time. On the next line type:

_bis_SR register(SCG1 + SCGO);

SR is the Status Register. Find the bit definitions for the status register in the User’s
Guide (section 4). Find the definitions for SCGO and SCG1 in the header file and notice
how they match the bit fields to turn off the system clock generator in the register. By the
way, the underscore before bis defines this is an assembly level call from C. _bis is a bit
set operation known as an intrinsic.

There is a divider in the MCLK clock tree. We will use divide-by-eight. Type this
statement on the next line and look up its meaning:

BCSCTL2 |= SELM_3 + DIVM_3;

The operator logically ORs the two values with the existing value in the register.
Examine these bits in the User’s Guide and header file.

At this point, your code should look like the code below. We have added the comments
to make it easier to read and understand. Click the Save button on the menu bar to save
the file.

#include <msp430g2231.h>

void main(void)

{
WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer
P1DIR = 0x40; // P1.6 output (green LED)
P10UT = 0; // LED off
BCSCTL3 |= LFXT1S_ 2; // LFXT1 = VLO
IFG1 &= ~OFIFG; // Clear OSCFault flag
__bis_SR_register(SCG1 + SCGO); // Stop DCO
BCSCTL2 |= SELM_3 + DIVM_3; // NCLK = VLO/8

}

Just one more thing — the last piece of the puzzle is to toggle the green LED. Leave
another line for spacing and type in the following code:

while(1)

{
P10UT = 0x40; // LED on
_delay _cycles(100);
P10UT = 0; // LED off

_delay _cycles(5000);
}

The P1OUT instruction was already explained. The delay statements are built-in intrinsic
function for generating delays. The only parameter needed is the number of clock cycles
for the delay. Later in the workshop we will find out that this is not a very good way to
generate delays — so you should not get used to using it. The while(1) loop repeats the
next four lines forever.
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13. Now, the complete code should look like the following. Be sure to save your work.

#include <msp430g2231._h>
void main(void)
{
WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer
P1DIR = 0x40; // P1.6 output (green LED)
P10UT = 0; // LED off
BCSCTL3 |= LFXT1S_2; // LFXT1 = VLO
IFG1 &= ~OFIFG; // Clear OSCFault flag
__bis_SR_register(SCG1 + SCGO); // Stop DCO
BCSCTL2 |= SELM_3 + DIVM_3; // NCLK = VLO/8
while(1)
P10OUT = 0x40; // P1.6 on (green LED)
_delay _cycles(100);
P10OUT = O; // green LED off
_delay _cycles(5000);
}
}

Great job! You could have just cut and pasted the code from VLO.txt in the Files folder,
but what fun would that have been? ©

14. Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Prob lems window.

15. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

16. Run the code. If everything is working correctly the green LED should be blinking about
once every three seconds. Running the CPU on the other clock sources will speed this up
considerably. This will be covered in the remainder of the lab exercise. When done, halt
the code.

17. Click on the Terminate Al button to stop debugging and return to the C/C++
perspective. Save your work by clicking File - Save As and select the save in
folder as C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3a.c.
Click Save. Close the Lab3a editor tab and double click on Lab3.c in the Projects pane.
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Note:

If you have decided NOT to solder the crystal on to LaunchPad, then skip to the
“Running the CPU on the DCO without a Crystal” section. But, you should
reconsider; as this is important information to learn.

Running the CPU on the Crystal

The crystal frequency is 32768 Hz, about three times faster than the VLO. If we run the previous
code using the crystal, the green LED should blink at about once per second. Do you know why
32768 Hz is a standard? It is because that number is 2*°, making it easy to use a simple digital
counting circuit to get a once per second rate — perfect for watches and other time keeping.
Recognize that we will also be sourcing the ACLK with the crystal.

1.

This part of the lab exercise uses the previous code as the starting point. We will start at
the top of the code and will be using both LEDs. Make both LED pins (P1.0 and P1.6)
outputs by

Changing: P1DIR = 0x40;

To: P1DIR = 0Ox41;

And we also want the red LED (P1.0) to start out ON, so

Change: P10OUT = 0;

To: P10OUT = 0xO01;

We need to select the external crystal as the low-frequency clock input.
Change: BCSCTL3 |= LFXT1S 2;

To: BCSCTL3 |= LFXT1S O;

Check the User’s Guide to make sure this is correct.

In the previous code we cleared the OSCFault flag and went on with our business, since
the clock system would default to the VLO anyway. Now we want to make sure that the
flag stays cleared, meaning that the crystal is up and running. This will require a loop
with a test. Modify the code to

Change: IFG1 &= ~OFIFG;
To: while(1IFG1 & OFIFG)

IFG1 &= ~OFIFG;
_delay_cycles(100000);
}

The statement while(1FG1 & OFIFG) tests the OFIFG in the IFG1 register. If that
fault flag is clear we will exit the loop. We need to wait 50 s after clearing the flag until
we test it again. The _delay_cycles(100000) ; is much longer than that. We need it
to be that long so we can see the red LED light at the beginning of the code. Otherwise it
would light so fast we would not be able to see it.

Finally, we need to add a line of code to turn off the red LED, indicating that the fault test
has been passed. Add the new line after the while loop:

P10OUT = O;
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5. Since we made a lot of changes to the code (and a chance to make a few errors) check to
see that you code looks like:

#include <msp430g2231.h>

void main(void)

{

WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer
P1DIR = 0x41; // P1.0 and P1.6 output
P10OUT = 0OxO01; // red LED on

BCSCTL3 |= LFXT1S O0; // LFXT1 = 32768 crystal

while(IFG1 & OFIFG)

IFG1 &= ~OFIFG; // Clear OSCFault flag
_delay_cycles(100000); // delay for flag and visibility
}
P10UT = 0; // red LED off
__bis SR _register(SCG1 + SCGO); // Stop DCO
BCSCTL2 |= SELM_3 + DIVM_3; // NCLK = 32768/8
while(1)
P10OUT = 0x40; // green LED on
_delay _cycles(100);
P10OUT = O; // green LED off
_delay _cycles(5000);
}
}

Again, you could have cut and pasted from XT.txt, but you’re here to learn. ©

6. Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Problems window.

7. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

8. Look closely at the LEDs on the LaunchPad and Run the code. If everything is working
correctly, the red LED should flash very quickly (the time spent in the delay and waiting
for the crystal to start) and then the green LED should blink every second or so. That is
three times the rate it was blinking before due to the higher crystal frequency. When
done, halt the code.

9. Click onthe Terminate Al button to stop debugging and return to the C/C++
perspective. Save your work by clicking File - Save As and select the save in
folder as C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3b.c.
Click Save. Close the Lab3b editor tab and double click on Lab3.c in the Projects pane.
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Running the CPU on the DCO and the Crystal

The slowest frequency that we can run the DCO is about 1MHz (this is also the default speed).
So we will get started switching the MCLK over to the DCO. In most systems, you will want the
ACLK to run either on the VLO or the 32768 Hz crystal. Since ACLK in our current code is
running on the crystal, we will leave it that way and just turn on and calibrate the DCO.

1. We could just let the DCO run, but let’s calibrate it. Right after the code that stops the
watchdog timer, add the following code:

it (CALBC1_1MHZ ==0xFF || CALDCO_1MHZ == OxFF)

while(1); // 1f cal constants erased, trap CPU!!

BCSCTL1 = CALBC1_1MHZ; // Set range
DCOCTL = CALDCO_1MHZ; // Set DCO step + modulation

Notice the trap here. It is possible to erase the segment A of the information flash
memory. Blank flash memory reads as OxFF. Plugging OxFF into the calibration of the
DCO would be a real mistake. You might want to implement something similar in your
own fault handling code.

2. We need to comment out the line that stops the DCO. Comment out the following line:
// __bis SR _register(SCGl + SCGO); // Stop DCO

3. Finally, we need to make sure that MCLK is sourced by the DCO.

Change: BCSCTL2 |= SELM_3 + DIVM_3;
To: BCSCTL2 |= SELM_O + DIVM_3;

Double check the bit selection with the User’s Guide and header file.
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4. The code should now look like:

#include <msp430g2231._h>

void main(void)

{

WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer

if (CALBC1_1MHZ ==OxFF || CALDCO_1MHZ == OxFF)

while(1); // 1T cal const erased, TRAP!
}
BCSCTL1 = CALBC1_1MHZ; // Set range
DCOCTL = CALDCO_1MHZ; // Set DCO step + modulation
P1DIR = 0x41; // P1.0 & 6 outputs(red/green LEDs)
P10OUT = 0OxO01; // red LED on
BCSCTL3 |= LFXT1S O; // LFXT1 = 32768 crystal

while(IFG1 & OFIFG)

IFG1 &= ~OFIFG; // Clear OSCFault flag
_delay_cycles(100000); // delay for flag and visibility
P10UT = 0; // red LED off
// __bis_SR _register(SCGl1 + SCGO); // Stop DCO
BCSCTL2 |= SELM_O + DIVM_3; // MCLK = DCO
while(1)
P1OUT = 0x40; // green LED on
_delay _cycles(100);
P10OUT = O; // green LED off
_delay _cycles(5000);
}
}

The code can be found in DCO_XT.txt, if needed.

5. Click the “Bui 1d” button and watch the tools run in the Console window. Check for
errors in the Problems window.

6. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

7. Look closely at the LEDs on the LaunchPad and Run the code. If everything is working
correctly, the red LED should be flash very quickly (the time spent in the delay and
waiting for the crystal to start) and the green LED should blink very quickly. The DCO
is running at 1MHz, which is about 33 times faster than the 32768 Hz crystal. So the
green LED should be blinking at about 30 times per second.
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8. Click onthe Terminate Al button to stop debugging and return to the C/C++
perspective. Save your work by clicking File > Save As and select the save in
folder as C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3c.c.
Click Save. Close the Lab3c.c editor tab and double click on Lab3.c in the Projects
pane.

Optimized Code Running the CPU on the DCO and the Crystal

The previous code was not optimized, but very useful for educational value. Now we will look at
an optimized version. Delete the code from your Lab3.c editor window (click anywhere in the
text, Ctrl-A, then delete). Copy and paste the code from OPT_XT.txt into Lab3.c. Examine the
code and you should recognize how everything works. A function has been added that
consolidates the fault issue, removes the delays and tightens up the code. Build, load, and run as
before. The code should work just as before. If you would like to test the fault function, short the
XIN and XOUT pins with a jumper before clicking the Run button. That will guarantee a fault
from the crystal. You will have to power cycle the LaunchPad to reset the fault.

Click on the Terminate Al button to stop debugging and return to the C/C++ perspective.
Save your work by clicking File - Save As and select the save in folder as
C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3d.c. Click Save. Close
the Lab3d.c editor tab.
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Running the CPU on the DCO without a Crystal

The slowest frequency that we can run the DCO is 1IMHz. So we will get started switching the
MCLK over to the DCO. In most systems, you will want the ACLK to run either on the VLO or
the 32768 Hz crystal. Since ACLK in our current code is running on the VLO, we will leave it
that way and just turn on and calibrate the DCO.

1. Double-click on Lab3.c in the Projects pane. Delete all the code from the file (Ctrl-A,
Delete). Copy and paste the code from your previously saved Lab3a.c into Lab3.c.

2. We could just let the DCO run, but let’s calibrate it. Right after the code that stops the
watchdog timer, add the following code:

if (CALBC1_1MHZ ==OxFF || CALDCO_IMHZ == OxFF)

while(1); // 1f cal constants erased, trap CPU!!
}

BCSCTL1 = CALBC1_1MHZ; // Set range
DCOCTL = CALDCO_1MHZ; // Set DCO step + modulation

Notice the trap here. It is possible to erase the segment A of the information flash
memory. Blank flash memory reads as OxFF. Plugging OxFF into the calibration of the
DCO would be a real mistake. You might want to implement something similar in your
own fault handling code.

3. We need to comment out the line that stops the DCO. Comment out the following line:
// __bis_SR _register(SCGl1 + SCGO); // Stop DCO

4. Finally, we need to make sure that MCLK is sourced by the DCO.

Change: BCSCTL2 |= SELM_3 + DIVM_3;
To: BCSCTL2 |= SELM_O + DIVM_3;

Double check the bit selection with the User’s Guide and header file.
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The code should now look like:

#include <msp430g2231._h>

void main(void)

{

WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer

if (CALBC1_1MHZ ==OxFF || CALDCO_1MHZ == OxFF)

while(1); // 1f cal const erased,trap
}
BCSCTL1 = CALBC1_1MHZ; // Set range
DCOCTL = CALDCO_1MHZ; // Set DCO step + mod
P1DIR = 0x40; // P1.6 output (green LED)
P10UT = 0; // LED off
BCSCTL3 |= LFXT1S_2; // LFXT1 = VLO
IFG1 &= ~OFIFG; // Clear OSCFault flag
//__bis_SR register(SCG1 + SCGO); // Stop DCO
BCSCTL2 |= SELM_O + DIVM_3; // NCLK = DCO/8
while(l)
{
P10OUT = 0x40; // green LED on
_delay _cycles(100);
P10OUT = O; // green LED off
_delay_cycles(5000);
}
}

The code can be found in DCO_VLO.txt, if needed.

Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Problems window.

Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

Run the code. If everything is working correctly, the green LED should blink very
quickly. With the DCO running at 1MHz, which is about 30 times faster than the 32768
Hz crystal. So the green LED should be blinking at about 30 times per second. When
done halt the code.

Click on the Terminate Al button to stop debugging and return to the C/C++
perspective. Save your work by clicking File - Save As and select the save in
folder as C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3e.c.
Click Save. Close the Lab3e.c editor tab and double click on Lab3.c in the Projects
pane.
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Optimized Code Running the CPU on the DCO and VLO

This is a more optimized version of the previous step’s code. Delete the code from your Lab3.c
editor window (click anywhere in the text, Ctrl-A, then delete). Copy and paste the code from
OPT_VLO.txt into Lab3.c. Examine the code and you should recognize how everything works.
A function has been added that consolidates the fault issue, removes the delays and tightens up
the code. Build, load, and run as before. The code should work just as before. There is no real
way to test the fault function, short of erasing the information segment A Flash — and let’s not do
that ... okay?.

Click on the Terminate Al button to stop debugging and return to the C/C++ perspective.
Save your work by clicking File - Save As and select the save in folder as
C:\MSP430_LaunchPad/Labs/Lab3/Files. Name the file Lab3f.c. Click Save and
then close the Lab3f.c editor pane.

Next, close the project by right-clicking on Lab3 in the C/C++ Projects window and select
Close Project.

ST

You’re done.
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Analog-to-Digital Converter

Introduction

This module will cover the basic details of the MSP430 Value Line analog-to-digital converter.

In the lab exercise you will write the necessary code to configure and run the converter.

Intr tion
Code Composer Studio
Initialization and GPIO
[ Analog-to-Digital Converter |
Interrupts and the Timer

Low-Power Optimization
Serial Communications
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Analog-to-Digital Converter

Fast Flexible ADC10

Fast Flexible ADC10

4

L R IR JER 2B 4

10-bit 8 channel SAR ADC

+ 6 external channels

+ Vcc and internal temperature
200 ksps+
Selectable conversion clock
Autoscan

+ Single

+ Sequence

+ Repeat-single

+ Repeat-sequence

Internal or External reference
Timer-A triggers

Interrupt capable

Data Transfer Controller (DTC)

Auto power-down

1.5V or 2.5V

Vi.
10-bit SAR

VR+

|

ADC10SC
TAL
TAO
TA2

Data
Transfer
Controller

Peripherals

4
1
1
RAM, Flash, 1
1
1
1
7

Sample Timing ...
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Sample Timing

Sample Timing

¢ Reference must settle for <30uS

& Selectable hold time

@ 13 clock conversion process

@ Selectable clock source
-ADC100SC (~5MHz)

-ACLK
-MCLK Smeing  Sampig  Goverson iy
- SMCLK y
SAMPCON | 13 XADC10CLKs
t, »la »
Jlxm:__ e o
apcrectk N _J-'"“"-.‘_ —‘\_’—4'5"'_/—\ et

Autoscan and DTC ...

Autoscan + DTC Performance Boost

Autoscan + DTC Performance Boost

o . , Data2

T 5 : Datal

N 8 -l-3| Data0

DTC Data2
// Software // Autoscan + DTC
Res[pRes++] = ADC10MEM; _BIS_SR(CPUCFF);

ADC10CTLO &= ~ENC;

ifT (pRes < NR_CONV)

Fully Automatic

CurrlNCH++;

if (CurrINCH = 3)
CurrINCH = 0O;

ADC10CTL1 &= ~INCH_3;

ADC10CTL1 |= CurrlINCH;

ADC10CTLO |= ENC+ADC10SC;

}
70 Cycles / Sample
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Lab 4: Analog-to-Digital Converter

Objective
The objective of this lab is to learn about the operation of the on-chip analog-to-digital converter.

In this lab exercise you will write and examine the necessary code to run the converter. The
internal temperature sensor will be used as the input source.

Lab4: ADC

e Measure internal temperature
¢ Set timing requirements
¢ Additional CCS features
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Procedure

Create a New Project

1. Create a new project (File > New - CCS Project) and name it Lab4.
Uncheck the “use default location” box. Using the Browse... button, navigate to:
C:\MSP430_LaunchPad\Labs\Lab4\Project. Click OK and then click Next.
The next three windows should default to the options previously selected (project type
MSP430, no inter-project dependencies selected, and device variant set to
MSP430G2231). Use the defaults and at the last window click Finish.

Create a Source File

2. Add asource file to the project (File > New -> Source File)and name it
Lab4.c and click Finish.

Write Lab4 Source File

Most coding efforts make extensive use of the “cut and paste” technique, or commonly known as
“code re-use”. The MSP430 family is probably more prone to the use of this technique than most
other processors. There is an extensive library of code example for all of the devices in both
assembly and C. So, it is extremely likely that a piece of code exists somewhere which does
something similar to what we need to do. Additionally, it helps that many of the peripherals in
the MSP430 devices have been deliberately mapped into the same register locations. In this lab
exercise we are going to re-use the code from the previous lab exercise along with some code
from the code libraries and demo examples.

3. We need to open the files containing the code that we will be using in this lab exercise.
Open the following two files using File > Open File..

e C:\MSP430_LaunchPad\Labs\Lab3\Files\OPT_VLO.txt

e C:\MSP430_LaunchPad\Labs\Lab2\Files\Temperature_Sense_Demo.txt

4. Copy all of the code in OPT_VLO . txt and paste it into Lab4_c. This will set up the
clocks:

¢ ACLK=VLO

e MCLK = DCO/8 (IMHz/8)
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5. Next, make sure the SMCLK is also set up:

Change: BCSCTL2 |= SELM_O + DIVM_3;
To: BCSCTL2 |= SELM_ O + DIVM_3 + DIVS_3;

The SMCLK default from reset is sourced by the DCO and DIVS_3 sets the SMCLK
divider to 8. The clock set up is:

e ACLK=VLO
e MCLK = DCO/8 (IMHz/8)

¢ SMCLK =DCO/8 (1MHz/8)

6. Asatest—build, load, and run the code. If everything is working correctly the green
LED should blink very quickly. When done, halt the code and click the Terminate
Al button to return to the C/C++ perspective.
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Set Up ADC Code

Next, we will re-use code from Temperature_Sense_Demo.txt to set up the ADC. This
demo code has the needed function for the setup.

7. From Temperature_Sense_Demo . txt copy the first four lines of code from the

ConfigureAdcTempSensor() function and paste it as the beginning of the while(1)
loop, just above the P1OUT line. Those lines of code are:

ADC10CTL1 INCH_10 + ADC10DIV_3;

ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC100N + ADC10IE;
_delay _cycles(1000);

ADC10CTLO |= ENC + ADC10SC;

8. Next, we are going to examine these code lines to make sure they are doing what we need

them to do. You will need to open the User’s Guide and header file for reference again.
(It might be easier to keep the header file open in the editor for reference).

ADC10CTL1 = INCH_10 + ADC10DIV_O;

ADC10CTLL1 is one of the ADC10 control registers. INCH_ 10 selects the internal
temperature sensor and ADC10D1V_0 selects divide-by-1 as the ADC10 clock.
Selection of the ADC clock is made in this register, and can be the internal ADC100SC
(5MHz), ACLK, MCLK or SMCLK. The ADC100SC is the default oscillator after
PUC. So we will use these settings.

ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC100N + ADC1OIE;
ADC10CTLO is the other main ADC10 control register:
e SREF_1: selects the range from V¢ to Vrer- (ideal for the temperature sensor)
e ADC10SHT_3: maximum sample-and-hold time (ideal for the temperature sensor)
e REFON: turns the reference generator on (must wait for it to settle after this line)
e ADC1O0ON: turns on the ADC10 peripheral

e ADCI1OIE: turns on the ADC10 interrupt — we do not want interrupts for this lab
exercise, so change the line to:

ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC10O0N;

The next line allows time for the reference to settle. A delay loop is not the best way to
do this, but for the purposes of this lab exercise, it’s fine.

_delay _cycles(1000);

Referring to the User’s Guide, the settling time for the internal reference is < 30us. As
you may recall, the MCLK is running at DCO/8. That is 1MHz/8 or 125 kHz. A value of
1000 cycles is 8ms, which is much too long. A value of 5 cycles would be 40us. Change
the delay time to that value:

_delay_cycles(5);
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The next line:

ADC10CTLO |= ENC + ADC10SC;

enables the conversion and starts the process from software. According to the user’s
guide, we should allow thirteen ADC10CLK cycles before we read the conversion result.
Thirteen cycles of the 5MHz ADC10CLK is 2.6us. Even a single cycle of the DCO/8
would be longer than that. We will leave the LED on and use the same delay so that we
can see it with our eyes. Leave the next two lines alone:

P10UT = 0x40;
_delay _cycles(100);

9. When the conversion is complete, the encoder and reference need to be turned off. The
ENC bit must be off in order to change the REF bit, so this is a two step process. Add the
following two lines right after _delay_cycles(100);

ADC10CTLO &= ~ENC;
ADC10CTLO &= ~(REFON + ADC100N);

10. Now the result of the conversion can be read from ADC1OMEM. Next, add the following
line to read this value to a temporary location:

tempRaw = ADC10OMEM;

Remember to declare the tempRaw variable right after the #include line at the
beginning of the code:

volatile long tempRaw;

The volati le modifier forces the compiler to generate code that actually reads the
ADC10MEM register and place it in tempRaw. Since we are not doing anything with
tempRaw right now, the compiler could decide to eliminate that line of code. The
volatile modifier prevents this from happening.

11. The last two lines of the whi le (1) loop turn off the green LED and delays for the next
reading of the temperature sensor. This time could be almost any value, but we will use
about 1 second in between readings. MCLK is DCO/8 is 125 kHz. Therefore, the delay
needs to be 125,000 cycles:

P10UT = 0;
_delay_cycles(125000);
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12. At this point, your code should look like the code below. We have added the comments
to make it easier to read and understand. Click the Save button on the menu bar to save

the file.

#include <msp430g2231.h>
volatile long tempRaw;
void FaultRoutine(void);

void main(void)

{

WDTCTL = WDTPW + WDTHOLD;
P1DIR = 0x41;
P10UT = O;

FaultRoutine();

BCSCTL1 = CALBC1_1MHZ;
DCOCTL = CALDCO_1MHZ;

BCSCTL3 |= LFXT1S_2;
IFG1 &= ~OFIFG;

BCSCTL2 |= SELM_O + DIVM_3 + DIVS_3;
while(1)

{

ADC10CTL1 = INCH_10 + ADC1O0DIV_O;
ADC10CTLO = SREF_1 + ADC1OSHT_3 + REFON

_delay_cycles(5);

ADC10CTLO |= ENC + ADC10SC;
P10UT = 0x40;

_delay _cycles(100);

ADC10CTLO &= ~ENC;

ADC10CTLO &= ~(REFON + ADC100N);
tempRaw = ADC10MEM;

P10UT = O;
_delay_cycles(125000);

}
void FaultRoutine(void)
P10UT = 0x01;

while(1);
}

//

//
//

//
/7/
//
//

//

/7/
//

/7/

Stop watchdog timer

P1.0 & 6 outputs
LEDs off

if (CALBC1_1MHZ ==0xFF || CALDCO_1MHZ == OxFF)

IT cal data is erased
run FaultRoutine()
Set range

Set DCO step + mod

LFXT1 = VLO

Clear OSCFault flag
MCLK=DC0O/8,SMCLK=DC0O/8

Temp Sensor ADC10CLK

+ ADC100N;

//
//
//
//
//
//
//
//
/7/

//
//

Wait for Ref to settle
Samp and convert start
P1.6 on (green LED)
Wait for conversion
Disable ADC conversion
Ref and ADC10 off

Read conversion value
green LED off

delay 1 second

red LED on
TRAP

Note: for reference, the code can found in Lab4.txt.
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13. Close the OPT_VLO.txt and Temperature_Sense_Demo. txt files. They are no
longer needed.

Build, Load, and Run the Code

14. Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Prob lems window.

15. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

16. Run the code. If everything is working correctly the green LED should be blinking about
once per second. Click halt to stop the code.

Test the ADC Conversion Process

17. Next we will test the ADC conversion process and make sure that it is working. In the
code line containing: tempRaw = ADC10OMEM;

double-click on tempRaw to select it. Then right-click on it and select Add Watch
Expression. If needed, click on the Watch tab near the upper right of the CCS screen
to see the variable added to the watch window.

18. Right-click on the next line of code: P10UT = O;

and select Toggle Breakpoint. When we run the code, it will hit the breakpoint
and stop, allowing the variable to be read and updated in the watch window.

19. Run the code. It will quickly stop at the breakpoint and the tempRaw value will be
updated. Do this a few times, observing the value. (It might be easier to press F8 rather
than click the Run button). The reading should be pretty stable, although the lowest bit
may toggle. A typical reading is about 734 (that’s decimal), although your reading may
be a little different. You can right-click on the variable in the watch window and change
the format to hexadecimal, if that would be more interesting to you.

20. Warm you finger up, like you did in the Lab2 exercise, and put it on the device as you
continue to press F8. You should see the measured temperature climb, confirming that
the ADC conversion process is working.
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Terminate Debug Session and Close Project

21. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

22. Next, close the project by right-clicking on Lab4 in the C/C++ Projects window and
select Close Project.

ST

You’re done.
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Interrupts and the Timer

Introduction

This module will cover the details of the interrupts and the timer. In the lab exercise we will

configure the timer and alter the code to use interrupts.

Intr tion ine
Code Composer Studio
Initialization and GPIO

Analog-to-Digital Converter

Interrupts and the Timer

Low-Power Optimization
Serial Communications

TimerArchitecture ...
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Module Topics
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Interrupts and the Timer

Timer_AZ2 Features

Timer_A2 Features

" Stop/Halt Continuous
* Asynchronous 16-b|t Timar is haled Timer contrucusly counts up

timer/counter

¢ Continuous, up-down,
up count modes

¢ Two capture/compare _
registers Up UpDown

Timer counts batween 0 and CCRO Timer counts between 0 and CCRO and 0

¢ PWM outputs i wreen e

¢ Twointerrupt vectors
for fast decoding

Interrupts and Stack ...
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Interrupts and the Stack

Interrupts and the Stack

Entering Interrupts
+ Any currently executing instruction is completed
+ The PC, which points to the next instruction, is pushed onto the stack
+ The SRis pushed onto the stack
+ The interrupt with the highest priority is selected

+ The interrupt request flag resets automatically on single-source flags;
Multiple source flags remain set for servicing by software

+ The SRis cleared; This terminates any low-power mode; Because the
GIE bit is cleared, further interrupts are disabled

+ The content of the interrupt vector is loaded into the PC; the program
continues with the interrupt service routine at that address

Before After
Interrupt Interrupt
Item1 Item1
SP—» Item2 TOS ltem2
PC
SP—» SR TOS
Vector Table ...
Interrupt Source | Interrupt System Word Address | Priority
Flag Interrupt
Power-up PORIFG
External Res et RSTIFG
Watchdog Timer+ WDTIFG Reset OFFFEh 31
Flash keyviolation KEYV (highest)
PC out-of-range
_ NMI NMIEG Non-maskable
Oscillator Fault OHFG Non-maskable OFFFCh 30
Hash memory access ACCVIFG Non-maskable
violation
OFFFAh 29
OFFF8h 28
OFFF6h 27
Watchdog Timer+ WDTIFG maskable OFFF4h 26
Timer_A2 TACCRO maskable OFFF2h 25
CCIFG
Timer_A2 TACCR1 maskable OFFFOh 24
CCIFG TAIFG
OFFEEh 23]
OFFECh 22
ADC10 ADCI10IFG maskable OFFEAh 21
usl USIIFG maskable OFFE8h 20
USISTTIFG
VO Port P2 (2) P2IFG.6 maskable OFFE6h 19
P2IFG.7
VO Port P1 (8) P1IFG.0to maskable OFFE4h 18
P1IFG.7
OFFE2h 17
OFFEOh 16
Unused OFFDEh to OFFCDh 15-0
ISR Coding ...
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ISR Coding
ISR Coding

#pragma vector=WDT_VECTOR

__interrupt void WDT_ISR(void)

{
IE1 &= ~WDTIE; // disable interrupt
IFG1 &= ~WDTIFG; // clear interrupt flag
WDTCTL = WDTPW + WDTHOLD; // put WDT back in hold state
BUTTON_IE |= BUTTON; // Debouncing complete

}

#pragma vector - the following function is an ISR for the listed vector
_interrupt void - identifies ISR name
No special return required

Lab...
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Lab 5: Timer and Interrupts

Lab 5: Timer and Interrupts

Objective

The objective of this lab is to learn about the operation of the on-chip timer and interrupts. In this
lab exercise you will write code to configure the timer. Also, you will alter the code so that it
operates using interrupts.

Lab5: Timer and Interrupts

» Configure Timer_A2
» Alter code to operate using interrupts
*Build and test
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Procedure

Create a New Project

1. Create a new project (File > New - CCS Project) and name it Lab5.
Uncheck the “use default location” box. Using the Browse... button, navigate to:
C:\MSP430_LaunchPad\Labs\Lab5\Project. Click OK and then click Next.
The next three windows should default to the options previously selected (project type
MSP430, no inter-project dependencies selected, and device variant set to
MSP430G2231). Use the defaults and at the last window click Finish.

Create a Source File

2. Add asource file to the project (File > New -> Source File)and name it
Lab5.c and click Finish.

Create Lab5.c Source File

The solution file from the last lab exercise will be used as the starting point for this lab exercise.
We have cleaned up the solution file slightly to make it a little more readable by putting the
initialization code into individual functions.

3. Openthe Lab5_Start.txtfileusing File - Open File..

e C:\MSP430_LaunchPad\Labs\Lab5\Files\Lab5_Start.txt

4. Copy all of the code in Lab5_Start. txt and paste it into Lab5.c. This will be the
starting point for this lab exercise.

5. Close the Lab5_Start.txtfile. Itis no longer needed.

6. Asatest—build, load, and run the code. If everything is working correctly the green
LED should be blinking about once per second and it should function exactly the same as
the previous lab exercise. When done, halt the code and click the Terminate All
button to return to the C/C++ perspective.

Using Timer_A2 to Implement the Delay

7. In the next few steps we are going to implement the one second delay that was previously
implemented using the delay intrinsic with the timer.

Find _delay_cycles(125000) ; and delete that line of code.
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8. We need to add a function to configure Timer_A2. Add a declaration for the function at
the top of the code, underneath the one for ADC10:

void ConfigTimerA2(void);

Then add a call to the function underneath the call to ConfigADC10;

ConfigTimerA2(Q);

And add a template for the function at the bottom of the program:
void ConfigTimerA2(void)
{

}

9. Next, we need to populate the ConfigTimerA2() template with the code to configure
the timer. We could take this from the example code, but it’s pretty simple, so we will do
it ourselves. Add the following code as the first line:

CCTLO = CCIE;

This enables the counter/compare register 0 interrupt in the CCTLO capture/compare
control register. Unlike the previous lab exercise, this one will be using interrupts. Next,
add the following two lines:

CCRO = 12000;
TACTL = TASSEL_1 + MC_2;

We would like to set up the timer to operate in continuous counting mode, sourced by the
ACLK (VLO), and generate an interrupt every second. Reference the User’s Guide and
header files and notice the following:

e TACTL is the Timer_A control register
e TASSEL_1 selects the ACLK
e MC_ 2 sets the operation for continuous mode

When the timer reaches the value in CCRO, an interrupt will be generated. Since the
ACLK (VLO) is running at 12 kHz, the value needs to be 12000 cycles.

10. We have enabled the CCRO interrupt, but global interrupts need to be turned on in order
for the CPU to recognize it. Right before the while(1) loop, add the following:

_BIS_SR(GIE);
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Create an Interrupt Sevice Routine (ISR)

11.

12.

13.

14.

At this point we have set up the interrupts. Now we need to create an Interrupt Service
Routine (ISR). Add the following code template to the bottom of Lab5.c:

#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_A (void)

{

}

These lines identify this as the TIMER ISR code and allow the compiler to insert the
address of the start of this code in the interrupt vector table at the correct location. Look
it up in the C Compiler User’s Guide. This User’s Guide was downloaded in the first lab.

Remove the code from inside the whi le(1) loop and paste it into the ISR template. This
will leave the whi le (1) loop empty for the moment.

Almost everything is in place for the first interrupt to occur. In order for the 2", 3",
4™ ... to occur at one second intervals, two things have to happen:

a) The interrupt flag has to be cleared (that’s automatic)
b) CCRO has to be set 12,000 cycles into the future

So add the following as the last line in the ISR:

CCRO +=12000;

We need to have some code running to be interrupted. Add the following code to the
while(1) loop:

P10OUT |= BITO;
for (i = 100; i > 0; 1--);
P1OUT &= ~BITO;
for (i = 5000; 1 > 0; i--);

This routine does not use any intrinsics. Therefore, we will be debugging the interrupts
and they will look fine in C rather than assembly. Do not forget to declare i at the top of
Lab5.c:

volatile unsigned int i;
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Modify Code in Functions and ISR

15. We will make some changes to the code for readability and LED function.

In FaultRoutine(),

e Change: P10OUT = 0x01;
o To: P1OUT BITO;

In ConfigLEDs(Q),

e Change: PI1DIR = 0x41;
e To: P1DIR BIT6 + BITO;

In the Timer ISR,
e Change: P10UT = 0x40;

o To: P10OUT |= BIT6;
and

e Change: P10UT = 0;

e To: P10UT &= ~BIT6;
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16. At this point, your code should look like the code below. We have added the comments
to make it easier to read and understand. Click the Save button on the menu bar to save
the file.

#

V
V

V
V
V
V
\%
\Y

Vi

{

}

include <msp430g2231.h>

olatile long tempRaw;
olatile unsigned int i;

oid FaultRoutine(void);
oid ConfigWDT(void);

oid ConfigClocks(void);
oid ConfigLEDs(void);
oid ConfigADC10(void);
oid ConfigTimerA2(void);

oid main(void)

ConfigWDTQ;
ConfigClocks();
ConfigLEDs(Q);
ConTigADC10Q);
ConfigTimerA2(Q);

BIS SR(GIE); // Turn on interrupts
while(1)

P10OUT |= BITO; // turn on red LED
for (i = 100; i > 0; 1--); // wait

P10UT &= ~BITO; // turn off red LED
for (i = 5000; 1 > 0; i--); // wait
}

void ConfigWDT(void)

{
WDTCTL = WDTPW + WDTHOLD; // Stop watchdog timer
}

void ConfigClocks(void)

{
if (CALBC1 1MHZ ==OxFF || CALDCO_1MHZ == OxFF)

FaultRoutine(); // 1f calibration data is erased
// run FaultRoutine()

BCSCTL1 = CALBC1_1MHZ; // Set range

DCOCTL = CALDCO_1MHZ; // Set DCO step + modulation

BCSCTL3 |= LFXT1S_2; // LFXT1 = VLO

IFG1 &= ~OFIFG; // Clear OSCFault flag

BCSCTL2 |= SELM_O + DIVM_3 + DIVS_3; //MCLK = DC0O/8, SMCLK = DCO/8
}

void FaultRoutine(void)

P10UT = BITO; // P1.0 on (red LED)
while(1): // TRAP
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void ConfigLEDs(void)

P1DIR
P10OUT

}
void ConfigADC10(void)

BIT6 + BITO; // P1.6 and P1.0 outputs
0; // LEDs off

ADC10CTL1 = INCH_10 + ADC10DIV_0; // Temp Sensor ADC10CLK
}

void ConfigTimerA2(void)

{

CCTLO = CCIE; // CCRO interrupt enabled
CCRO = 12000; // one second

TACTL = TASSEL_1 + MC_2; // ACLK, continuous mode
}

// Timer_A2 interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_A (void)

ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC10O0N;

_delay_cycles(5); // Wait for ADC Ref to settle
ADC10CTLO |= ENC + ADC10SC; // Sampling and conversion start
P10OUT |= BIT6; // P1.6 on (green LED)

_delay _cycles(100);

ADC10CTLO &= ~ENC; // Disable ADC conversion
ADC10CTLO &= ~(REFON + ADC100N); // Ref and ADC10 off

tempRaw = ADC10MEM; // Read conversion value

P10UT &= ~BIT6; // green LED off

CCRO += 12000; // Add one second to CCRO

Note: for reference, the code can found in Lab5_Finish.txt in the Files folder.

Build, Load, and Run the Code

17. Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Problems window.

18. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of main().

19. Run the code and observe the LEDs. If everything is working correctly, the red LED
should be blinking about twice per second. This is the while(1) loop that the Timer is
interrupting. The green LED should be blinking about once per second. This is the rate
that we are sampling the temperature sensor. Click halt to stop the code.
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Testing the Code

20. Make sure that the tempRaw variable is still in the watch window. If not, then double-
click tempRaw on the code line tempRaw = ADC1OMEM; to select it. Then right-click
on it and select Add Watch Expression. If needed, click on the Watch tab near
the upper right of the CCS screen to see the variable added to the watch window.

21. In the Timer_A2 ISR, find the line with PLOUT &= ~BIT6; and place a breakpoint
there. To place a breakpoint, right-click on the line of code and select Toggle
Breakpoint.

22. Run the code. The debug window should quickly stop at the breakpoint and the
tempRaw value will be updated. Observe the watch window and test the temperature
sensor as in the previous lab exercise, running the code each time by pressing F8.

Terminate Debug Session and Close Project

23. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

24. Next, close the project by right-clicking on Lab5 in the C/C++ Projects window and
select Close Project.

ST

You’re done.
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Low-Power Optimization

Introduction

This module will explore low-power optimization. In the lab exercise we will show and

experiment with various ways of configuring the code for low-power optimization.

Intr tion
Code Composer Studio
Initialization and GPIO
Analog-to-Digital Converter
Interrupts and the Timer

| Low-Power Optimization

Serial Communications

Low PowerModes ...
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Low-Power Optimization

Low-Power Modes

Low-Power Modes

CPU and Clocks

CPU active. All enabled clocks active

CPU, MCLK disabled. SMCLK, ACLK active

CPU, MCLK disabled. DCO disabledif not used for
SMCLK. ACLK active

CPU, MCLK, SMCLK, DCO disabled. ACLK active

CPU, MCLK, SMCLK, DCO disabled. ACLK active

CPU and all clocks disabled

Active
LPMO
LPM1
/— ASTMMI
(e mp Q ”D LPM2
Cj LPM3
- wot
Tirwe Expired, Overflow ) WDTIFG = 1 WOTIFG = 0 LPM4
= o 'Q"—'G) FEETNMI is Rieset Pin
WOTIFG =1 WOIT is Active
e AETAMI
WOT Activs, - HMI Acsive
Saecurity Koy Vickation
— — S
Active Mode
CPUOFF = 1 ) CPU Is Actve . CPUOFF = 1
S000 -0 | Peripheral Medulus Ave Active OSCOFF = 1
 saaio S SCa0=1
B
" e
u U Ofl, MGLK O,
\K LK On, AGLK On cpul;m Q‘Jéf&'!.f’"’
_ ACLKON
BT \ s -
ECW 1 CPUDFF = Ty e
o1 =0 CPUGFF = 1 SCO0=1 1, "___
g SCG0=0 SCo1 =1 M2
CPUOH MELK 08, sca1=1 CPUOH, I'.!PIKQ! SMOLE
Dm off, SMCLK On, O#, DO O, ACLK On
RGO sz
(i’UCP‘ MCLE O, SMCLK
DG Ganerator O 1 DGO on DGO O, AGLK On |:r, Ganeratos o
ot used for SMCLK

Operation ...
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Low-Power Operation

Low-Power Operation

¢ Power-efficient MSP430 apps:
« Minimize instantaneous current draw
+ Maximize time spent in low power modes

¢ The MSP430 is inherently low-power, but your
design has a big impact on power efficiency

¢ Proper low-power design techniques make the
difference

32768 |

MSP430 Always-on

s 23OUA‘

: low-power peripherals ‘

On demand

MCLK |
| Ejeol——— il Wi, L
H CPU and peripherais TUA ¥

“Instant on” clock

Operation ...

Low-Power Operation

¢ Power draw increases with...
+ Vcc
+ CPU clock speed (MCLK)
+ Temperature
¢ Slowing MCLK reduces instantaneous power, but
usually increases active duty cycle
+ Power savings can be nullified

+ The ULP ‘sweet spot’ that maximizes performance for the
minimum current consumption per MIPS: 8 MHz MCLK

+ Full operating range (down to 2.2V)
+ Optimize core voltage for chosen MCLK speed

)

AT T

MCLK and Vcc ...
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System MCLK & Vcc
System MCLK & Vcc

A
Legend:
16 MHz
Supply voltage range,
n during flash memory
= programming
0 12 MHz
z
2
2 Supply voltage range,
g during program execution
(T
5 emmz
]
2
1]
|-
Ll

18V 22V 27TV 33V 36V
Supply Voltage -V

@ Match needed clock speed with required Vcc to achieve the lowest possible
power consumption. Unreliable execution will result if VVcc drops below the
minimum required for the selected frequency.

¢ All G2 device operate up to 16MHz. 1st phase devices only provide MHz DCO
constant. Higher frequencies must be manually calibrated. 2nd phase will have
all constants. Always check the datasheet.

Pin Muxng ...
P [ M [
Table 2. Terminal Functions
5
TERMINAL oo 14 DOVSS
HO. I DESCRIPTION BOTADCLKACLE O 2 13 OHNEZETAD
HAME | e &1 10mhn. o] ‘
K PW /| RS& a0 1O 4
P1.0¢ Genara-purpase dighal O FIn Bams 1o fa
TADCLK! - 1 Timerd_A, clock signal TACLK Input. B 4SMC LK/TC o B ¥
2 L] = - L4sMCLKTOR O & @ o aTo
ACLKI ACLE Sgnal outpud P S ——
40 ADC10 anaiog Input A0' 1 STALL SCLKTMS O 7 & [P 18 TH0 VSDIVSCLITONTCLK.

¢ Each pin has up to four functions
¢ Top selection (above) is default
¢ Register bits (below) select pin function

Table 18 Port P1 (P1.0 to P14 Z) Pin Functions -- MSP430G2x31

CONTROL BITS / SIGHALS
FINHAME (P1x) | x FUNCTION f— j— [’?,?54",-‘53‘.
EE] P1X (10} [ [ [
TADCLK! TAD TACLE [} 1 o
ACLK! ACLK 1 ]
A0 AD x % 1iy=0)

Unusedpins...
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Unused Pin Termination

Unused Pin Termination

¢ Digital input pins subject to shoot-through current

+ Inputvoltages between VIL and VIH cause shoot-through if
inputis allowed to “float” (left unconnected)

¢ Port/Os should
+ Driven as outputs
+ Bedriven to Vcc or ground by an external device
+ Have a pull-up/down resistor

(Digital) CMOS Inverter

Vin
Vec

J cc
Vin\ :1 | \Vout

AfL t

Lab...
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Lab 6: Low-Power Modes

Objective

The objective of this lab is to learn various techniques for making use of the low-power modes.
We will start with the code from the previous lab exercise and reconfigure it for low-power
operation. As we modify the code, measurements will be taken to show the effect on power
consumption.

Lab6: Low-Power Modes

e Implement LPM3 during while(1) loop
 Eliminate software delays
e Measure current draw (optional)
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Procedure

Create a New Project

1. Create a new project (File > New - CCS Project) and name it Lab6.
Uncheck the “use default location” box. Using the Browse... button, navigate to:
C:\MSP430_LaunchPad\Labs\Lab6\Project. Click OK and then click Next.
The next three windows should default to the options previously selected (project type
MSP430, no inter-project dependencies selected, and device variant set to
MSP430G2231). Use the defaults and at the last window click Finish.

Create a Source File

2. Add asource file to the project (File > New -> Source File)and name it
Lab6.c and click Finish.

Create Lab6.c Source File

The solution file from the last lab exercise will be used as the starting point for this lab exercise.
3. Openthe Lab5 Finish.txtfileusing File - Open File..

e C:\MSP430_LaunchPad\Labs\Lab5\Files\Lab5_Finish.txt

4. Copy all of the code in Lab5_Finish.txt and paste it into Lab6.c. This will be the
starting point for this lab exercise.

5. Close the Lab5 Finish.txt file. Itis no longer needed.

Reconfigure the I/O for Low-Power

If you have a digital multimeter (DMM), you can make the following measurements; otherwise
you will have to take our word for it. The sampling rate of one second is probably too fast for
most DMMs to settle, so we will extend that time to three seconds.

6. Find and change the following lines of code:

e InConfigTimerA2():

Change: CCRO = 12000;

To: CCRO = 36000;
e Inthe Timer_AO ISR :

Change: CCRO += 12000;

To: CCRO += 36000;

7. The current drawn by the red LED is going to throw off our current measurements, so
comment out the two PLOUT lines inside the whi le(1) loop.
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8. Asatest - build, load, and run the code. If everything is working correctly the green
LED should blink about once every three seconds. When done, halt the code and click
the Terminate Al button to return to the C/C++ perspective.

Baseline Low-Power Measurements

9. Measure the voltage between Vcc and GND at header J6. You should have a value
around 3.7 Vdc. Record your measurement here:

10. Currently, the MCLK and SMCLK are set to 125 kHz (DCQ/8) using the divider. Since
we will need the MCLK to be 1 MHz later on in this lab exercise, we will make this
change now. Make the following change in the ConTigClocks() function:

Change: BCSCTL2 |= SELM_O + DIVM_3 + DIVS_3;
To: BCSCTL2 = O;

11. Build, load, and run the code. If everything is working correctly the green LED should
blink about once every three seconds.

If you are interested in the state of the MSP430 registers, click:
View - Registers

You can expand any of the peripheral registers to see how they each are set up. If you see
“Unable to read” in the Value column, try halting the code. The emulator cannot read
memory or registers while code is executing.

When done, click the Terminate Al button to return to the C/C++ perspective.

12. Now we will completely isolate the target area from the emulator, except for ground.
Remove all five jJumpers on header J3. Set your DMM to measure pA. Connect the
DMM red lead to the top (emulation side) VVcc pin on header J3 and the DMM black lead
to the bottom (target side) VVcc pin on header J3. Next, press the Reset button on the
LaunchPad board.

If your DMM has a low enough effective resistance, the green LED on the board will
flash normally and you will see a reading on the DMM. If not, the resistance of your
meter is too high. Oddly enough, we have found that low-cost DMMs work very well.
You can find one on-line for less than US$5.

Now we can measure the current drawn by the MSP430 without including the LEDs and
emulation hardware. (Remember that if your DMM is connected and turned off, the
MSP430 will be off too). This will be our baseline current reading. Measure the current
between the blinks of the green LED.

You should have a value around 362 pA.

Record your measurement here:

Carefully replace the four jumpers on header J3 except for Vcc.
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Configure Device Pins for Low-Power

We need to make sure that all of the device pins are configured to draw the lowest current
possible. Referring to the device datasheet and the LaunchPad board schematic, we notice that
Portl defaults to GP10O. Only P1.3 is configured as an input to support push button switch S2,
and the rest are configured as outputs. P2.6 and P2.7 default to crystal inputs. We will configure
them as GPIO.

13.

14.

15.

16.

17.

18.

Rename the ConfigLEDs () function declaration, call, and function name to
ConfigPins().

Delete the contents of the ConfigPins() function and insert the following lines:

P1DIR ~BIT3;
P10OUT = O;

(Sending a zero to an input pin is meaningless).

There are two pins on Port2 that are shared with the crystal XIN and XOUT. This lab
will not be using the crystal, so we need to set these pins to be GPIO. The device
datasheet indicates that P2SEL bits 6 and 7 should be cleared to select GP1O. Add the
following code to the ConfigPins() function:

P2SEL = ~(BIT6 + BIT7);

P2DIR |= BIT6 + BIT7;

P20UT = O;

At this point, your code should look like the code below. We have added the comments
to make it easier to read and understand. Click the Save button on the menu bar to save
the file. The middle line of code will result in a “integer conversion resulted in
truncation” warning at compile time that you can ignore.

void ConfigPins(void)

{
P1DIR = ~BIT3; // P1.3 input, others output
P10OUT = O; // clear output pins
P2SEL = ~(BIT6 + BIT7); // P2.6 and 7 GPIO
P2DIR |= BIT6 + BIT7; // P2.6 and 7 outputs
P20UT = O; // clear output pins
}

Now build, load and run the code. Make sure the green LED blinks once every three
seconds. Halt the code and click the Terminate Al button to return to the C/C++
perspective.

Next, remove the four jumpers on header J3. Press the Reset button on the LaunchPad
board and measure the current between the blinks of the green LED.

You should have a value around 362 pA.

Record your measurement here:
No savings here, but there is not much happening on the board to cause any issues.

Carefully replace the four jumpers on header J3 except for Vcc.
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MSP430G2231 Current Consumption

The current consumption of the MSP430G2231 looks something like the graph below (ignoring
the LED). The graph is not to scale in either axis and our code departs from this timing
somewhat. With the CPU active, 360 pA is being consumed all the time. The current needed for
the ADC10 reference is 250 pA, and is on for 33 us out of each sample time. The conversion
current of 600 pA is only needed for 3 us (our code isn’t quite this timing). If you could limit the
amount of time the CPU is active, the overall current requirement would be significantly reduced.
(Always refer to the datasheet for design numbers. And remember, the values we are getting in
the lab exercise might be slightly different than what you get.)

Not to scale ADC10 conversion

600uA for 3uS

ADC10 reference ON
250uA for 33uS

CPU active at 1MHz
360uA for 3 seconds

Current

Time 3s

Replace the while(1) loop with a Low-Power Mode

The majority of the power being used by the application we are running is spent in the while(1)

loop waiting for an interrupt. We can place the device in a low-power mode during that time and
save a considerable amount of power.

19. Delete all of the code from the while(1) loop.
Delete _BIS_SR(GIE); from above the loop.

Delete volatile unsigned int i; from the top of Lab6.c.

Then add the following line of code to the whi le (1) loop:
_bis_SR_register(LPM3_bits + GIE);

This code will turn on interrupts and put the device in LPM3 mode.

You may notice that the syntax has changed between this line and the one we deleted.

MSP430 code has evolved over the years and the second line is the preferred format
today; but the syntax of the first line is still accepted by the compiler.

Getting Started with the MSP430 LaunchPad - Low-Power Optimization 6-11



Lab 6: Low-Power Modes

20. At this point, the entire main() routine should look like the following:

void main(void)

ConfigWDTQ);
ConfigClocks();
ConfigPins();
ConfigADC10Q);
ConfigTimerA2();

while(1)

_bis_SR register(LPM3_bits + GIE); // Enter LPM3 with interrupts
}

21. The Status Register (SR) bits that are set by the above code are:

e SCGO: turns off SMCLK
e SCG1: turnsoff DCO
e CPUOFF: turns off the CPU

When an ISR is taken, the SR is pushed onto the stack automatically. The same SR value
will be popped, sending the device right back into LPM3 without running the code in the

while(2) loop. This would happen even if we were to clear the SR bits during the ISR.

Right now, this behavior is not an issue since this is what the code in the whi le(1) does
anyway. If your program drops into LPM3 and only wakes up to perform interrupts, you

could just allow that behavior and save the power used jumping back to main(), just so

you could go back to sleep. However, you might want the code in the whi le(1) loop

to actually run and be interrupted, so we are showing you this method.

Add the following code to the end of your Timer_A0 ISR:
_bic_SR register_on_exit(LPM3_bits);
This line of code clears the bits in the popped SR.

More recent versions of the MSP430 clock system, like the one on this device,
incorporate a fault system and allow for fail-safe operation. Earlier versions of the
MSP430 clock system did not have such a feature. It was possible to drop into a low-
power mode that turned off the very clock that you were depending upon to wake you up.
Even in the latest versions, unexpected behavior can occur if you, the designer, are not
aware of the state of the clock system at all points in your code. This is why we spent so
much time on the clock system in the Lab3 exercise.
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22. The Timer_AOQ ISR should look like the following:

// Timer_AO interrupt service routine

#pragma vector=TIMERAO_VECTOR

__interrupt void Timer_A (void)

{
ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON
_delay_cycles(5); //
ADC10CTLO |= ENC + ADC10SC; //
P10OUT |= BIT6; //
_delay _cycles(100);
ADC10CTLO &= ~ENC; //
ADC10CTLO &= ~(REFON + ADC100N); //
tempRaw = ADC1OMEM; //
P10OUT &= ~BIT6; //
CCRO += 36000; //
_bic_SR register_on_exit(LPM3_bits); //

}

+ ADC100N;

Wait for ADC Ref to settle
Sampling and conversion start
P1.6 on (green LED)

Disable ADC conversion

Ref and ADC10 off

Read conversion value

green LED off

Add one second to CCRO

Clr LPM3 bits from SR on exit

23. Now build, load and run the code. Make sure the green LED blinks once every three
seconds. Halt the code and click the Terminate Al button to return to the C/C++

perspective.

24. Next, remove the four jumpers on header J3. Press the Reset button on the LaunchPad
board and measure the current between the blinks of the green LED.

You should have a value around 0.6 pA.

Record your measurement here:

This is a big difference! The CPU is spending the majority of the sampling period in

LPM3, drawing very little power.

Carefully replace the four jumpers on header J3 except for Vcc.

A graph of the current consumption would look something like this:

Not to scale

Current

CPU in LPM3
(6UA for 3 seconds

ADC10 conversion
600uA for 3uS

ADC10 reference ON
250uA for 33uS

CPU active at 1MHz
360uA for 33uS

Time

v

3s
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Fully Optimized Code for Low-Power

The final step to optimize the code for low-power is to remove the software delays in the ISR.
Timer_A2 can be used to implement these delays instead and save even more power. It is
unlikely that we will be able to measure this current savings without an oscilloscope, since it
happens so quickly. But we can verify that the current does not increase.

25.

26.

27.

28.

Examine the Timer_AO0 ISR. The delay operations must be altered to reflect the change
to 1 MHz MCLK which we made earlier in lab exercise. This will keep the code working

correctly. For a 30 pus reference settling delay -

Change: _delay_cycles(5);
To: _delay_cycles(500);

Build, load, and run the code. The green LED will blink once every three seconds, but
the blink rate will be very, very short in duration. Halt the code. If you are having a
difficult time with the code modifications, this code can be found in Lab6a.txt in the Files
folder.

Make sure the code is still reading the temperature by setting tempRaw in the watch
window (it may already be there from the earlier lab exercise). Set a breakpoint on CCRO
+= 36000; in the Timer_AO0 ISR code.

Run the code and once execution stops at the breakpoint, warm your finger and place it
on the MSP430. Run the code using F8 and notice the value for tempRaw in the watch
window. You should see the variable’s value change, just as it has done in the ADC lab
exercise. Click the Terminate Al button to return to the C/C++ perspective.
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Code Explanation

We need three separate delay times in this application:

e Three seconds between samples
o 30 ps for reference settling
e 3 pus for conversion time

There are many, many methods to implement these delay times. We will be using Timer_A2 to
implement both the 3 second sampling time as well as the 30 ps settling time. We will then use
the ADC10 conversion complete flag to interrupt the code when the conversion is complete.

We will be using both capture and compare registers; CCRO and CCR1. They have somewhat
different functionality; but both are able to generate interrupts. When the Timer A Register
(TAR) reaches CCRO, it will cause the TAR to reset. So we will use CCR1 to trigger the 3 second
sample time, and CCRO to trigger the 3 second + 30 pus reference settling time.

The process will be as follows:

CPU initializes and goes into LPM3

Timer_A2’s CCR1 interrupts every 3 seconds; Timer_A1 ISR turns on the reference and
exits to allow the 3 seconds + 30 us CCRO timer to go off

LPM3 is re-entered in main()

The Timer_AO ISR runs after 30 us and starts ADC conversion; it then configures the
ADC10 conversion complete interrupt; Timer TAR register resets

LPM3 is re-entered inmain()

The ADC10 ISR runs when the conversion complete flag posts and completes ADC
handling

LPM3 is re-entered inmain()

29.

The current Timer_A2 ISR is triggered by the TAR reaching CCRO. To reduce confu-
sion, change the top of the Timer_A2 ISR to look like this:

// Timer_A2 CCRO interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_AO0 (void)
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30. Make the following changes to the ConfigTimerA2() function:

void ConfigTimerA2(void)

{
CCTL1 = CCIE + OUTMOD_3; // CCR1 int. enabled set/reset mode

CCR1 = 36000; // three seconds

CCTLO = CCIE; // CCRO int. enabled

CCRO = 36100; // three seconds + settling time
TACTL = TASSEL_1 + MC_1; // ACLK, up mode

3

e OUTMOD_3 makes sure that the Timer acts as expected, resetting the TAR
when the TAR reaches CCRO.
e MC 1 places the Timer in up mode

See the User’s Guide for further details.

31. Add the following ISR template to the bottom of Lab6.c:

// Timer_A2 CCR1 interrupt service routine
#pragma vector=TIMERA1l VECTOR
__interrupt void Timer_Al (void)

{
b

32. Copy the first and last lines from Timer_AO ISR and place them in Timer_ALl ISR:

// Timer_A2 CCR1 interrupt service routine
#pragma vector=TIMERA1l_VECTOR
__interrupt void Timer_Al (void)

ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC100ON;
_bic_SR register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit

bs

33. Inthe Timer_AO0 ISR, delete the first two lines and the CCRO line. This removes the
settling time software delay. Compare your code to the code below.

// Timer_A2 CCRO interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_AO0 (void)

{
ADC10CTLO |= ENC + ADC10SC; // Sampling and conversion start
P10UT |= BIT6; // P1.6 on (green LED)
_delay _cycles(500);
ADC10CTLO &= ~ENC; // Disable ADC conversion
ADC10CTLO &= ~(REFON + ADC100N); // Ref and ADC10 off
tempRaw = ADC10MEM; // Read conversion value
P10OUT &= ~BIT6; // green LED off
_bic_SR _register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit
}
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34. While it is true that both Timer_A2 ISRs are triggered by single source interrupts and the
flags should be automatically cleared, it never hurts to clear them manually. This will be
especially helpful if you re-use this code on an MSP430 where those flags are not
automatically cleared. Add the first lines to each ISR as shown:

// Timer_A2 CCRO interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_A0 (void)

{
CCTLO &= ~CCIFG; // Clear CCRO int flag
ADC10CTLO |= ENC + ADC10SC; // Sampling and conversion start
P10UT |= BIT6; // P1.6 on (green LED)
_delay _cycles(500);
ADC10CTLO &= ~ENC; // Disable ADC conversion
ADC10CTLO &= ~(REFON + ADC100N); // Ref and ADC10 off
tempRaw = ADC10MEM; // Read conversion value
P10OUT &= ~BIT6; // green LED off
_bic_SR register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit
}

// Timer_A2 CCR1 interrupt service routine
#pragma vector=TIMERA1_VECTOR
__interrupt void Timer_Al (void)

CCTL1 &= ~CCIFG; // Clear CCR1 int flag
ADC10CTLO = SREF_1 + ADC10SHT 3 + REFON + ADC100ON;
_bic_SR register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit

3

35. Now build, load and run the code. The green LED will be blinking so quickly that it will
be difficult to see. Verify that the code is working properly as shown earlier in the lab
exercise. Halt the code and click the Terminate Al button to return to the C/C++
perspective. If you are having a difficult time with the code modifications, this code can
be found in Lab6b.txt in the Files folder.

36. The final thing to tackle is the conversion time delay in the Timer_AO ISR. The ADC
can be programmed to provide an interrupt when the conversion is complete. That will
provide a clear indication that the conversion is complete.

Add the following ADC10 ISR template to the bottom of Lab6.c:

// ADC10 interrupt service routine
#pragma vector=ADC10_VECTOR
__interrupt void ADC10 (void)

{
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37.

38.

39.

40.

Copy all of the lines in Timer_AOQ ISR below delay_cycles and paste them into the
ADC10 ISR.

In the Timer_AO0 ISR delete the code from the _delay_cycles line through the P1OUT
line.

At the top of the ADC10 ISR, add ADC10CTLO &= ~ADC10I1FG; to clear the interrupt
flag.

Lastly, we need to enable the ADC10 interrupt. In the Timer_Al ISR, add + ADC101E
to the ADCL10CTLO register.

The three ISRs should look like this:

// Timer_A2 CCRO interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_AO0 (void)

CCTLO &= ~CCIFG; // Clear CCRO int flag
ADC10CTLO |= ENC + ADC10SC; // Sampling and conversion start
P10OUT |= BIT6; // P1.6 on (green LED)

_bic_SR register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit

}

// Timer_A2 CCR1 interrupt service routine
#pragma vector=TIMERA1_VECTOR
__interrupt void Timer_Al (void)

CCTL1 &= ~CCIFG; // Clear CCR1 int flag
ADC10CTLO = SREF_1 + ADC10SHT_3 + REFON + ADC100N + ADCI10IE;
_bic_SR_register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit

}

// ADC10 interrupt service routine
#pragma vector=ADC10_VECTOR
__interrupt void ADC10 (void)

{
ADC10CTLO &= ~ADC10I1FG; // Clear ADC10 int flag
ADC10CTLO &= ~ENC; // Disable ADC conversion
ADC10CTLO &= ~(REFON + ADC100N); // Ref and ADC10 off
tempRaw = ADC10MEM; // Read conversion value
P10OUT &= ~BIT6; // green LED off
_bic_SR register_on_exit(LPM3_bits); // Clr LPM3 bits from SR on exit
}

41.

Build and load the project. Eliminate any breakpoints and run the code. Every three
seconds the green LED should flash so quickly that it will be difficult to see. Set a
breakpoint on the P10UT line in the ADC10 ISR and verify that the code is working
properly as shown earlier. Click the Terminate Al button to halt the code and
return to the C/C++ perspective. If you are having a difficult time with the code
modifications, this code can be found in Lab6c.txt in the Files folder.
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Summary

Our code is now as close to optimized as it gets, but again, there are many, many ways to get
here. Often, the need for hardware used by other code will prevent you from achieving the very
lowest power possible. This is the kind of cost/capability trade-off that engineers need to make
all the time. For example, you may need a different peripheral — such as an extra timer — which
costs a few cents more, but provides the capability that allows your design to run at its lowest
possible power, thereby providing a battery run-time of years rather than months.

42. Remove the four jumpers on header J3. Press the Reset button on the LaunchPad board
and measure the current between the blinks of the green LED.

You should have a value around 0.7 pA. The extra 0.1 pA is needed by Timer_A2
running on the VLO.

Record your measurement here:

A graph of the current consumption would look something like this:

Not to scale ADC10 conversion
600uA for 3uS
- L
o , ADC10 reference ON
s e 250UA for 33US
TuA for 3 seconds CPU active at 1MHz
360uA for a few uS

L

Time 3s

That may not seem like much of a savings, but every little bit counts when it comes to

battery life. To quote a well known TI engineer: “Every joule wasted from the battery is
a joule you will never get back”

Congratulations on completing this lab! Remove and turn off your meter and replace all
of the jumpers on header J3. We are finished measuring current.
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Terminate Debug Session and Close Project

43. Close the project by right-clicking on Lab6 in the C/C++ Projects window and
select Close Project.

ST

You’re done.
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Introduction

This module will cover the details of serial communications. In the lab exercise we will
implement a software UART and communicate with the PC through the USB port.

Intr tion ine
Code Composer Studio
Initialization and GPIO
Analog-to-Digital Converter
Interrupts and the Timer
Low-Power Optimization

Serial Communications
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Serial Communications

Universal Serial Interface

Universal Serial Interface

The USI provides the basic hardware for syn chronous
serial communication for SPI and 12C

Three-wire SPI mode support

12C mode support

Variable data lengths

Slave operation in LPM4 - no internal clock required

Selectable MSB or LSB data order

START and STOP detection for 12C mode with automatic SCL* control
Programmable clock generation

Selectable clock polarity and phase control

® 6 6 6 0 0 o o

* serial clock line

Protocols ...
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Protocols
Protocols
CLK .
¢ SPI | - SPI MOSI SPI
+ Serial Peripheral Interface Master | \ggr\? 4 Slave

+ Single Master/Single Slave

¢ 12C l

SDA -

+ Inter-Integrated Circuit & T T T T

Interface ucC DAC | | ADC rtC
- Single Master/Multiple Slaves [Master| | Slave| | Slave | | Slave

SWUART Implementation ...

Software UART Implementation

Software UART Implementation

¢ A simple UART implementation, using the Capture &
Compare features of the Timer to emulate the UART
communication

¢ Half-duplex and relatively low baud rate (9600 baud
recommended |Im|t| , but’ 2400 baud in our code (1 MHz
DCO and no crysta

¢ Bit-time (how many clock ticks one baud is) is calculated
based on thetimer clock & the baud rate

¢ One CCRregisteris set up to TXin Timer Compare mode,
toggling based on whether the corresponding bit is 0 or 1

¢ Theother CCRregister is set up to RXin Timer Capture
mode, similar principle

¢ Thefunctions are set up to TX or RX a single byte (8-bit)
appended by the start bit & stop bit

PAVoJoJIle-1ilelaMaleld=H htip://focus.ti.com/lit/an/slaa078a/slaa078a.pdf

USB COM Port ...

Application note: http://focus.ti.com/lit/an/slaa078a/slaa078a.pdf
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USB COM Port Communication
USB COM Port Communication

¢ Emulation hardware implements emulation
features as well as a serial communications port

¢ Recognized by Windows as part of composite
driver

¢ UART Tx/Rx pins match Spy-Bi-Wire JTAG
interface pins

HI, LO, IN
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Lab 7: Serial Communications

Objective

The objective of this lab is to learn serial communications with the MSP430 device. In this lab
exercise we will implement a software UART and communicate with the PC using the USB port.

Lab7: Serial Communication

* Alter code to run on WDT+ interval
timer

* Add codeto detect
above/below/within temperature range

* Add UART code to send data to PC
via USB COM port
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Procedure

Create a New Project

1. Create a new project (File > New - CCS Project) and name it Lab7.
Uncheck the “use default location” box. Using the Browse... button, navigate to:
C:\MSP430_LaunchPad\Labs\Lab7\Project. Click OK and then click Next.
The next three windows should default to the options previously selected (project type
MSP430, no inter-project dependencies selected, and device variant set to
MSP430G2231). Use the defaults and at the last window click Finish.

Create a Source File

2. Add asource file to the project (File > New -> Source File)and name it
Lab7.c and click Finish.

Create Lab7.c Source File

In this lab exercise we will be building a program that transmits “HI”, “LO” or “IN” using the
software UART code. This data will be communicated through the USB COM port and then to
the PC for display on a terminal program. The UART code utilizes TIMER_AZ2, so we will need
to remove that dependence from our starting code. Then we will add some “trip point” code that
will light the red or green LED indicating whether the temperature is above or below some set
temperature. Then we will add the UART code and send messages to the PC. The code file from
the last lab exercise will be used as the starting point for this lab exercise.

3. Open the Lab6a.txt fileusing File > Open File..

e C:\MSP430_LaunchPad\Labs\Lab6\Files\Lab6a.txt

4. Copy all of the code from Lab6a.txt and paste it into Lab7 .c. This will be the
starting point for this lab exercise. You should notice that this is not the low-power
optimized code that we created in the latter part of the Lab6 exercise. The software
UART implementation requires Timer_A2, so using the fully optimized code will not be
possible. But we can make a few adjustments and still maintain fairly low-power.

Close the Lab6a . txt file. It is no longer needed.

5. Asatest - build, load, and run the code. If everything is working correctly the green
LED will blink once every three seconds, but the blink duration will be very, very short.
The code should function exactly the same as the previous lab exercise. When done, halt
the code and click the Terminate Al button to return to the C/C++ perspective.
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Remove Timer_A2 and Add WDT+ as the Interval Timer

6. We need to remove the previous code’s dependence on Timer_A2. The WDT+ can be
configured to act as an interval timer rather than a watchdog timer. Change the
ConTigWDT () function so that it looks like this:

void ConfigWDT(void)

WDTCTL = WDT_ADLY_250; // <1 sec WDT interval
IE1 |= WDTIE; // Enable WDT interrupt

3

The selection of intervals for the WDT+ is somewhat limited, but WDT_ADLY_250 will
give us a little less than 1 second delay running on the VLO.

WDT_ADLY_250 sets the following bits:

e WDTPW: WDT password
e WDTTMSEL: Selects interval timer mode
e WDTCNTCL: Clears count value

e WDTSSEL: WDT clock source select

7. The code in the Timer_AO ISR now needs to run when the WDT+ interrupts trigger:

e Change this:

// Timer_A2 interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_A (void)

{

e Tothis:

// WDT interrupt service routine
#pragma vector=WDT_VECTOR
__interrupt void WDT(void)

8. There is no need to handle CCRO in the WDT ISR. Delete the CCRO += 36000; line.
Also, there is no need to set up Timer_A2 now. Delete all the code inside the
ConfigTimerA2() function.

9. Build, load, and run the code. Make sure that the code is operating like before, except
that the green LED will blink about once per second. When done, halt the code and click
the Terminate Al button to return to the C/C++ perspective. If needed, this code
can be found in Lab7a.txt in the Files folder.

10. Next, delete both P1OUT lines in the WDT ISR. We are going to need both LEDs for a
different function in the following steps.
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Add the UART Code

11. We need to change the Transmit and Receive pins (P1.1 and P1.2) on the MSP430 from
GPIO to TAO function. Add the first line shown below to your ConfigPins()
function and change the second line as follows:

void ConfigPins(void)

{
P1SEL |= TXD + RXD; // P1.1 & 2 TAO, rest GPIO
P1DIR = ~(BIT3 + RXD); // P1.3 input, other outputs
P10OUT = O; // clear outputs
P2SEL = ~(BIT6 + BIT7); // make P2.6 & 7 GPIO
P2DIR |= BIT6 + BIT7; // P2.6 & 7 outputs
P20UT = O; // clear outputs

}

12. We will need a function that handles the transmit software; adding a lot of code tends to
be fairly error-prone. So, add the following function by copying and pasting it from
Transmit.txt in the Files folder to the end of Lab7.c:

// Function Transmits Character from TXByte

void Transmit()

{
BitCnt = OxA; // Load Bit counter, 8data + ST/SP
while (CCRO = TAR) // Prevent async capture

CCRO = TAR; // Current state of TA counter

CCRO += Bitime; // Some time till Ffirst bit
TXByte |= 0x100; // Add mark stop bit to TXByte
TXByte = TXByte << 1; // Add space start bit
CCTLO = CCISO + OUTMODO + CCIE; // TXD = mark = idle
while ( CCTLO & CCIE ); // Wait for TX completion

}

Be sure to add the function declaration at the beginning of Lab7.c:

void Transmit(void);
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13. Transmission of the serial data occurs with the help of Timer_A2 (it sets all the timing
that will give us a 2400 baud data rate). Copy the contents of Timer_A2 ISR.txt
and paste it to the end of Lab7.c:

// Timer AO interrupt service routine
#pragma vector=TIMERAO_VECTOR
__interrupt void Timer_A (void)

CCRO += Bitime; // Add Offset to CCRO
if (CCTLO & CCISO) // TX on CCIOB?
{
if ( BitCnt == 0)
CCTLO &= ~ CCIE ; // All bits TXed, disable interrupt
}
else
{
CCTLO |= OUTMODZ2; // TX Space
if (TXByte & 0x01)
CCTLO &= ~ OUTMOD2; // TX Mark
TXByte = TXByte >> 1;
BitCnt —-;
}

14. Now we need to configure Timer_A2. Enter the following lines to the
ConFigTimerA2() function in Lab7.c so that it looks like this:

void ConfigTimerA2(void)
{
CCTLO = OUT; // TXD Idle as Mark
TACTL = TASSEL_2 + MC_2 + ID_3; // SMCLK/8, continuos mode
s

15. To make this code work, add the following definitions at the top of Lab7.c:

#define TXD BIT1 // TXD on P1.1
#define RXD BIT2 // RXD on P1.2
#define Bitime 13*4 // 0x0D

unsigned iInt TXByte;
unsigned char BitCnt;

16. Since we have added a lot of code, do a test build by clicking:
Project - Build Active Project

and check for any syntax errors.
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17. Now, add the following declarations to the top of Lab7.c:

volatile long tempSet = 0;
volatile int i;

The tempSet variable will hold the first temperature reading made by ADC10. We will
then compare future readings against it to determine if the new measured temperature is
hotter or cooler than that value. Note that we are starting the variable out at zero. That
way we can use its non-zero value after it’s been set to make sure we only set it once.
We’ll need the ““i”” in the code below

18. Add the following control code to the whii le(1) loop right after line containing
_bis_SR register(LPM3_bits + GIE);

This code is available in Whi e . txt:

if (tempSet == 0)

tempSet = tempRaw; // Set reference temp
}
if (tempSet > tempRaw + 5) // test for lo

P10OUT = BIT6; // green LED on

P10UT &= ~BITO; // red LED off

for (i=0;i<5;i1++)

TXByte = TxLO[i];

Transmit();
}
if (tempSet < tempRaw - 5) // test for hi
{
P10OUT = BITO; // red LED on
P10OUT &= ~BIT6; // green LED off
for (i=0;i<5;i1++)
TXByte = TxHI[i];
Transmit();
}
}

if (tempSet <= tempRaw + 2 & tempSet >= tempRaw - 2)
// test for iIn range
P10UT &= ~(BITO + BIT6); // both LEDs off
for (i=0;i<5;i++)

TXByte = TxIN[i];
Transmit();

3

This code sets three states for the measured temperature; LO, HI and IN that are indicated by the
state of the green and red LEDs. It also sends the correct ASCII sequence to the Transmit()
function.
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19. The ASCII equivalents that will be transmitted to the PC are:
o LO<LF><BS><BS>: 0x4C, 0x4F, 0x0A, 0x08, 0x08
o HI<LF><BS><BS>:  0x48, 0x49, 0x0A, 0x08, 0x08
e IN<LF><BS><BS>: 0x49, Ox4E, 0x0A, 0x08, 0x08
The terminal program on the PC will interpret the ASCII code and display the desired
characters. The extra Line Feeds and Back Spaces are used to format the display on the

Terminal screen.

Add the following arrays to the top of Lab7.c:

unsigned int TxHI[]={0x48,0x49,0x0A,0x08,0x08};
unsigned int TxLO[]={0x4C,0x4F,0x0A,0x08,0x08%};
unsigned int TxIN[]={0x49,0x4E,0x0A,0x08,0x08}%};

Test the Code

20. Build and load the code. If you are having problems, compare your code with
Lab7Finish.txt found in the Files folder. Don’t take the easy route and copy/paste
the code. Figure out the problem ... the process will pay off for you later.

21. Next, we need to find out what COM port your LaunchPad is connected to. In Windows,
click Start -> Run and enter devmgmt.msc into the dialog box, then click OK. This
should open the Windows Device Manager. If not, then take your own path to open the
Device Manager.

Click the + next to Ports and find the port named MSP430 Application UART. Write
down the COM port number here . (The one on our PC was COM45). Close
the Device Manager.

22. CCS should be in the Debug perspective now. Click View -> Other.. and, in the
Show View window, click the + next to Terminal. Select Terminal below that and click
OK.
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23. A Terminal pane will appear on your screen. Click the Settings button = in the
Terminal pane and make the following selections:

% Terminal Settings

Connection Type:

|Serial v|
Settings:

Port: | coM4s v|
BaudRate: | EXCIN ~ |
Datafits: |8 v|
StopBits: | 1 v|
Parity: | None v|
Flow Control: | None v|

Timeout (sec): | 5 |

[ oK H Cancel ]

Then click OK.

24. Run the code. In the Terminal Pane, you will likely see IN displayed over and over
again. You can right-click in the Terminal pane and select Clear All if that helps.

Exercise the code. When you warm up the MSP430, the red LED should light and the
Terminal should display HI. When you cool down the MSP430, the green LED should
light and the Terminal should display LO. In the middle, both LEDs are off and the
Terminal should display IN.

This would also be a good time to note the size of the code we have generated. In the
Console pane at the bottom of your screen note:

MSP430: Program loaded. Code Size - Text: 770 bytes Data: 58 bytes

Based on what we have done so far, you could create a project more than twice the size
of this code and still fit comfortably inside the MSP430G2231 memory.

When you are done, halt the code.
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Terminate Debug Session and Close Project

25. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

26. Next, close the project by right-clicking on Lab7 in the C/C++ Projects window and
select Close Project.

STOP %!]I

You’re done.
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